POWERLOGIC® SMS 4.0, SU1
System Manager Software
Setup Guide

Instruction Bulletin
Retain for future use.

HAZARD CATEGORIES AND
SPECIAL SYMBOLS

Read these instructions carefully and look at the equipment to become
familiar with the device before trying to install, operate, service or maintain it.
The following special messages may appear throughout this bulletin or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.
The addition of either symbol to a “Danger” or “Warning” safety label
indicates that an electrical hazard exists which will result in personal injury if
the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER
DANGER indicates an imminently hazardous situation which, if not
avoided, will result in death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation which, if not
avoided, can result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not
avoided, can result in minor or moderate injury.

CAUTION
CAUTION, used without the safety alert symbol, indicates a potentially
hazardous situation which, if not avoided, can result in property damage.

PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and maintained
only by qualified personnel. No responsibility is assumed by Schneider
Electric for any consequences arising out of the use of this material.
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Introduction
What is SMS 4.0?

Introduction
What is SMS 4.0?
PowerLogic® System ManagerTM Software 4.0 (SMS 4.0) provides access to real-time
and historical system data using a standard web browser format. With SMS 4.0, you can:

• view real-time data in meters, bar charts, tables, and trends
• view documents (in PDF and HTML format) and web links to certain Schneider Electric
sites, as well as to your own favorite sites

• view “web-enabled” devices from SMS Setup (when adding the device to SMS Setup,
you can set it to be web enabled)

• set user preferences for the SMS 4.0 browser display
• store and view historical waveforms and reports
• create and use Advanced Reports (standard feature in System Manager Professional,
optional purchase in System Manager Standard). There is an online help file in the
Advanced Reports add-on application

• configure and retrieve alarm information
• create and view data diagrams (if you also have installed the GFX interactive graphics
software)
The SMS Setup client continues to be available. See SMS Setup Client, below for more
information.
There are three SMS 4.0 products: System Manager Device Limited (System Manager
DL), System Manager Standard (System Manager SE), and System Manager
Professional (System Manager PE). Throughout these instructions, all three products may
also be called “SMS 4.0” or “SMS.” Not all of the SMS 4.0 features are available in all
three products. When a feature is limited to one or two of the SMS 4.0 products, the
instructions will explain the limitation.

SMS Web Client
You can view SMS information, as a “web client,” from any computer that has Microsoft
Internet Explorer, version 5.5, service pack 2, or greater (Advanced Reports requires
Internet Explorer version 6). As long as the browser can connect to the SMS server
computer, users have full access to the SMS web client features.

Note
Microsoft no longer makes Internet Explorer 5.5, Service Pack 2 available. If you do not have
Internet Explorer 5.5, Service Pack 2, you can download Internet Explorer version 6 from
Microsoft.

For a description of all of the web client features, see the SMS 4.0 online user’s guide,
accessed from within the web client. See Table 2– 1 on page 5 for hardware requirements.
See “SMS Licensing Requirements” on page 9 for an explanation of licensing
requirements.
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SMS Setup Client
In addition to viewing information through a browser connection, you can access
information through the SMS Setup client, which runs on the server computer (Start >
Programs > POWERLOGIC > SMS Setup). You will use SMS Setup to set up your system
devices: to add and configure devices and their network addresses. With SMS Setup, you
can also set up historical logging and system alarms, and view real-time data (from the
server computer).
For information about launching SMS Setup, see the SMS 4.0 User’s Guide (from the
SMS browser, click the System tab; then click “SMS 4.0 User’s Guide” from the list in the
left pane of the window. For help using SMS Setup, refer to SMS Setup online help file
(from within SMS Setup, click Help > Setup Utility Help).
Part of SMS Setup is the PowerLogic Network Server (PLNS), which resides on the SMS
4.0 server. To ensure that browser connections reflect correct device information, you
must run the PLNS as a Windows service. You will set the “server as a service” status
during SMS 4.0 installation.

What are Terminal Server/Terminal Services?
Terminal Server and Terminal Services are Microsoft components that allow multiple
users at remote computers to open simultaneous sessions on the server computer without
any of them taking over the main desktop. After you install Terminal Server, you must
purchase the applicable licensing components from Microsoft.
In System Manager DL or System Manager SE, you can only access SMS Setup from the
server computer; thus, only one connection to SMS Setup can be made at a time (there is
no Terminal Server or Terminal Services available for these two SMS products).
If you have System Manager PE, you can connect to SMS Setup from the server and from
remote browsers. To be able to connect remotely, you must install and activate Terminal
Server or Terminal Services before you install SMS. You must own sufficient Microsoft®
Windows® client access licenses (CAL) and Terminal Services client access licenses
(TSCAL) for the number of users that will connect to the SMS 4.0 server simultaneously.
Contact Microsoft to purchase the necessary licenses.

Note
The browser must be Internet Explorer, version 5.5, service pack 2, or greater (the optional
Advanced Reports add-on requires Internet Explorer, version 6). You cannot use Netscape to
view SMS 4.0 screens. If you do not have service pack 2 installed, you must download and
install Internet Explorer 6.0.

Contents of this Package
In this package you will find:

• SMS 4.0 installation CDs
• PowerLogic Software Policy: containing license agreement; be sure you agree with the
terms of this license agreement before you break the seal on your software

• SMS 4.0 Installation Notes, containing last-minute instructions for installing and using
SMS 4.0

• Product serial number to register your System Manager products; the serial number
is found on a silver sticker on the software box, and on a card inside the software box.

2
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User Documentation and Help Files
SMS 4.0 includes a number of documents and online help files. The table below lists some
typical topics, the product you will use, and where to find the related information.
What do you want to do?

Where do you go?

Where can you find help?

Review requirements and special settings for SMS this Setup Guide
installation

See the sections entitled “Prerequisites” on page 3 and
“Administrative Concerns” on page 6 of this Setup Guide.

Installation: SMS 4.0 (including GFX, Information
Manager, and optional device types)

SMS 4.0 Launchpad installation

SMS 4.0 Setup Guide; see chapter 2 for the installation
procedure you will follow.

Launch (access) SMS Setup client

Start Menu

SMS 4.0 User’s Guide (HTML help file, accessed from the
browser); or see “Accessing the SMS Setup Client” on
page 80 of this setup guide.

View Information via your browser

Start Menu

SMS 4.0 User’s Guide (HTML help file, accessed from the
browser); or see “Accessing the Server Computer” on
page 75 of this setup guide.

Set up system devices or user accounts

SMS Setup client

Setup Utility online help file

Set up reports

Advanced Reports add-on

Advanced Reports online help file

Information Manager

Information Manager online help file

SMS Setup client

Setup Utility online help file

Set up advanced reports (standard with SMS PE,
optional with SMS SE)
Set up historical logging and device alarms

Prerequisites
Before you install SMS 4.0, ensure that you have all of the prerequisites listed below:
1. Windows Accounts that You Will Need. The person who installs SMS must be
logged on to the server computer as a Windows Administrator on the local
computer.
— This account cannot be logged on to the domain during installation.
— This account should be unique. It cannot have the same name as any other on the
domain.
In addition, you will be asked for a Windows Administrator account during the
installation procedure. This should be a unique account that is dedicated for use with
SMS. It will be used to synchronize SMS components with Windows. Add this account
before you begin the installation.
— This account’s password cannot be blank, and it must be set to never expire. When
creating this account, do not check the box “User must change password at next
logon.”
— IIS_WPG membership: If you install SMS on a computer that has Windows Server
2003 as its operating system, you must use an Administrator account that also
belongs to the IIS Worker Process Group (IIS_WPG group). To add an
administrator to the IIS_WPG, follow these steps:
- Click Start > Administrative Tools > Computer Management.
- Highlight Local Users and Groups, and double-click Groups.
- Double-click IIS_WPG.
- At the IIS_WPG Properties screen, click Add to display the Select Users screen.
- In the “Enter the object names to select box,” type the administrators ID.
- Click OK, then click OK to close the IIS_WPT Properties screen.
- Close the Computer Management screen.

© 2006 Schneider Electric All Rights Reserved
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2. Disk Space for Installation: The SMS server computer must have a C drive. Disk
space requirements vary, depending on the SMS product you have purchased. See
Table 2– 1 on page 5 for space requirements for logging historical data.
3. Operating System: The SMS server computer must have the appropriate operating
system for the product you have purchased. See Table 2– 1 on page 5 for operating
system requirements.
4. Internet Explorer: Ensure that Internet Explorer version 5.5, service pack 2, or greater
is installed on the server computer (Advanced Reports requires version 6). This
service pack is no longer available from Microsoft; if you need to upgrade, you can
download Internet Explorer version 6. You may install more recent versions or service
packs, but you cannot use Netscape.
5. SQL Service Pack 3: SMS 4.0 requires that SQL Service Pack 3 be installed on the
server computer. If you need to install SQL Service Pack 3, see “Installing SQL
Service Pack 3” on page 51. If SQL Service Pack 3 is already installed on the server
computer, verify that the SQL agent is set to automatic:
a. Display the SQL Server Service Manager box: click Start > Programs > Startup >
Service Manager.
b. In the Server box, enter <computer name>\smsxxxx (where “<computer name>” is
the name of the server computer, and where smxxxx is the name of the SMS
product: SMS3000, SMS1500, PMX1500, or SMS121).
c. From the Services pull-down box, select SQL Server Agent.
d. Check the box named “Auto-start service when OS starts.”
e. Close the SQL Server Service Manager box.
6. Uninstalling Terminal Server/Terminal Services:
If you are installing SMS DL or SE on a computer that has Microsoft Server 2003 as its
operating system, and if Terminal Server is already installed, you must uninstall
Terminal Server before you begin the Launchpad installation (you will be able to reinstall it after you follow the launchpad steps). To uninstall Terminal Server:
a. Click Start > Control Panel > Add or Remove Programs.
b. At the Add/Remove Components screen, click Add or Remove Windows
Components.
c. At the Windows Components window, uncheck Terminal Server.
If you are installing SMS DL or SE on a computer that has Windows 2000 Server as its
operating system, and if Terminal Services is already installed, you must uninstall
Terminal Services before you begin the Launchpad installation (you will be able to reinstall it after you follow the launchpad steps). To uninstall Terminal Services:
a. Click Start > Settings > Control Panel. Then double-click Add or Remove
Programs.
b. At the Add or Remove Programs screen, click Add/Remove Windows
Components.
c. At the Windows Components window, uncheck Terminal Services. Click Next.
7. Upgrades: If you are upgrading from a previous version of SMS, you must have
installed SMS version 3.3.2.3 or SMS version 4.0 on the SMS server computer.
8. Database Backup: If you are upgrading from a previous version of SMS, be sure that
you back up your SMS databases before you begin.
Table 2– 1 lists the hardware/software requirements to run SMS 4.0 on the server
computer. “SMS Licensing Requirements” on page 9 lists the minimum licensing
requirements to provide SMS 4.0 browser connections.

4
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SMS 4.0 Hardware/Software Requirements
SMS 4.0 Product

Requirement

System Manager DL

2.4 GHz/733 MHz1

Processor Speed
(recommended/minimum)
RAM (recommended/minimum)
Disk Space
(recommended/minimum)

System Manager SE

512 MB/256 MB1
10/5 GB free space 1

System Manager PE Server

Remote Browser Computer

2.8 GHz/1 GHz

N/A

1 GB/512 MB

256 MB/64 MB

20 GB/10 GB free space

N/A

Note: You must also add space for
logging. For guidelines, see
“Calculating Space Requirements
for Logging” on page 6.
PC Monitor Resolution

800x600 minimum

Operating System

Windows XP Professional, SP1 (SP2 also supported)

Windows XP Professional, SP2 2

and Service Pack (SP)

Windows 2000 Professional, SP3

Windows 2000 Server/Advanced
Server, SP4

Windows 2000 Server/2000 Advanced Server, SP3
(SP4 required for Advanced Reports)

For Advanced Reports Add-on

Browser

Windows Server 2003 (SP1 also supported)

Windows Server 2003 (SP1 also
supported)

N/A

Windows XP Pro, SP2

Windows XP Pro, SP2

Windows 2000 Srvr, SP4

Windows 2000 Srvr, SP4

Windows Adv Srvr, SP4

Windows 2000 Adv Srvr, SP4

Windows Srvr 2003, any
version

Windows Srvr 2003, any version

Any operating system that
supports Internet Explorer
version 5.5, SP 2, or greater

Any operating system that
supports Internet Explorer,
version 6 or greater

Internet Explorer 5.5, SP 2 or greater. SP 2 must be obtained from Microsoft (www.microsoft.com).
Advanced Reports add-on: Internet Explorer 6.0
Netscape and earlier versions of Internet Explorer cannot be used.

Internet Information Services (IIS)

Version 5.0 (or greater) required; enables SMS 4.0 to serve web pages to browser clients

Terminal Server/Terminal Services

N/A

.NET Framework, V. 1.1, SP 1
GFX
Maximum Number of Simultaneous
Browser Connections

Included in the Launchpad installation.
Required to use the Diagrams feature in SMS, and to view GFX drawings.
1 (optional purchase: can be increased to 6)

Maximum Number of Simultaneous 16 (can be increased to 32
Device Connections
with optional SMSDL32U
product)

N/A

Required for accessing the SMS
N/A
Setup client from a remote browser

10 (optional purchase: can be
increased in increments of 5 to a
maximum of 30)
Unlimited

N/A
N/A
N/A

N/A

1 You will not be able to install SMS unless the computer meets the minimum requirements. If you want to add the “Advanced Reports Add-On for System Manager
SE, use the processor speed, RAM, and disk space requirements for System Manager PE.
2 The following two issues are true for any non-server operating system (currently only Windows XP):
SQL issue: The number of database connections is limited.Adding additional features, such as custom applications, could adversely affect performance. Contact
your Schneider Electric representative for more information.
IIS issue: IIS has a hard-coded limit of 10 simultaneous browser connections. Each time you launch Internet Explorer on the same computer, two or more of these
browser connections are used. Thus, you can quickly reach the limit. At that point, the web server will not allow additional connections.
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Calculating Space Requirements for Logging
Before you log history data, you should ensure that you have sufficient hard disk space for
the logging you want to do. Use the following formulas to estimate your disk space
requirements for historical logging.
1. Estimate the disk space needed to log one template.
To determine the space used by any template:
(# of quantities logged + 1) * 31 bytes/sample * # of samples logged/day *
# of devices assigned to the template
For example, if you log 59 quantities for 25 devices at 15-minute intervals (96
samples/day/device), the formula is:
(59 + 1) * 31 * 96 * 25 = 4,464,000 bytes = 4.46 MB/day
2. Estimate the total disk space needed for historical logging.
Multiply the figure from Step 1 by the number of days of data retained in your history
database (default is 400 days; see the SMS Setup online help file for instructions on
changing the default).
In this example, the total disk space needed for historical logging would be:
4.46 MB/day * 400 days = 1.78 GB

Note
You need to perform these calculations for every template that you are using.

Administrative Concerns
Security Setup
To access SMS 4.0, every user needs an SMS user name and password. You must
understand SMS user account information before you create and assign these user
names and IDs. For instructions on adding user accounts, see the SMS Setup help file.
Each SMS 4.0 user who accesses SMS Setup through Terminal Services or Terminal
Server (System Manager PE only) must have a unique SMS user name and password. (In
SMS, a user name/password can be used by only one user at a time.) The level—1
through 10—that you give the user provides specific access rights to SMS. The access
level table (in SMS Setup online help file) shows the level required for each SMS feature.
Although SMS Setup requires specific security levels in order to access its features, the
SMS 4.0 browser allows full access to any user ID level. You do not need unique user IDs
for browser access; multiple users can use the same user name and password.

When Data Execution Prevention (DEP) is on the Computer
According to the Microsoft Help and Support site, “DEP is a set of hardware and software
technologies that perform additional checks on memory to help prevent malicious code
from running on a system.” When DEP is on a computer, you may not be able to run the
Advanced Reports install. If you see a message telling you that the install cannot continue
because of hardware-based Data Execution Protection, the install will stop. Contact your
local Schneider Electric representative for help in disabling DEP. After Advanced Reports
is installed, you can enable DEP again.

6
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Microsoft Windows/SQL Updates
Periodic updates to such applications as Microsoft Windows and SQL can create issues in
SMS. Before you install an upgrade to one of these applications, it is a good idea to check
with your local Schneider Electric representative. The representative may have
information about whether the upgrade could a negative affect on your SMS system. This
is also true of other third-party products, such as Crystal Enterprise.

Avoid Blank Passwords in Windows Accounts
When setting up the PowerLogic Network Server to run as a Windows service (which you
do during the SMS launchpad installation), you use an administrator or power user
account. This account cannot have a blank password. Using a blank password will cause
the PowerLogic Network Server service to be unable to start.

Communications Protocol Setup (Upgrades Only)
For the best performance of your SMS product, we highly recommend that you use
TCP/IP for your communications protocol. The communications protocol is set in the SMS
Configuration Utility (Start > Programs > POWERLOGIC > TOOLS > SMS Config Utility;
or, from within SMS Setup, click Tools > Configuration Utility). If you need help when
making changes in this utility, see the SMS Setup online help file.

SQL Considerations
Please verify the SQL configuration on the SMS 4.0 server computer before you continue
with the SMS 4.0 installation. There are two possibilities:

• The SMS 4.0 installs add a SQL instance named “SMS3000,” with mixed-mode
authentication. If you change or delete this instance, you cannot log on to SMS.

• If you do not want to install the SMS3000 instance via the Launchpad, you can use your
own copy of SQL Server software to create your own instance. But the instance must
be named SMS3000, and it must have mixed-mode authentication.
By default, SMS new installations add SQL with the “sa” account and a “DBMaster”
password. If you want to change the password, you can do so later.
During upgrade installations, you can change the blank password to “DBMaster.”

Terminal Server/Terminal Services Considerations
Both Terminal Server and Terminal Services use Remote Desktop Protocol (RDP), which
uses a special port (3389). If port 3389 is blocked by a firewall on your server, you can do
one of the following:

• RDP operates over TCP port 3389. You can open this port.
• To connect to a specific system on your LAN: Configure Port Forwarding on the firewall
to send traffic from port 3389 to the computer with which you want to connect.

Cross-Language Installations
When SMS is installed on an operating system that does not use the same language
(such as French SMS on an English operating system), it is a cross-language installation.
If you will have a cross-language installation, you must ensure that the regional settings
will display correctly for your language. To do this, log on to the SMS server computer
before you install SMS with the administrator account that will be used to run the Windows

© 2006 Schneider Electric All Rights Reserved
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services. Set the regional settings for that account. During installation, when you are
prompted for an account to run SMS as Windows service, use this account.

Popup Blockers
If you are using certain popup blockers (such as from Google or Yahoo), certain SMS
popup screens may not be able to display. Examples are the real-time trend screen and
the screen notifying you that the maximum number of browser connections has been met.
To ensure that these SMS popup windows display correctly, set the blocker to allow popup
windows from the SMS server address to display.

Font Setting/Viewing from the Browser
Certain computers have a wide screen, or wide aspect ratio display, option. If these
computers are set for “large fonts” (in the Display screen of the Control Panel), screens
will not display correctly in the SMS browser. If SMS screens are cut off in the browser
view, please check the font setting for that computer.

Alarm Log Size
Although you set a maximum number of alarms to be viewed in the SMS 4.0 browser
window, you also set a maximum in SMS Setup. If you set a limit in the browser (System
tab > User Preferences) that is greater than the one in SMS Setup, the alarm log viewed in
the browser will be smaller than expected. (There is a limit of 1,000 alarms in the browser.)

IIS Log File Size
You must install IIS (Internet Information Services) on the SMS server computer to be able
to serve web pages to remote clients (installation instructions are in chapter 2). IIS
periodically writes log files to this location: c:\Windows\System32\Logfiles\W3SVC1.
These files are not automatically deleted or FIFO’d, and over time, they can take up
significant hard disk space. To ensure they do not cause problems, you could periodically
delete or archive older files.

Customizing SMS 4.0
You can replace the SMS 4.0 banner and About box with your own graphics. See
“Customizing the About Box Icon and Banner” on page 81.
You can add your own documents and web links to those that are already part of the SMS
4.0 browser. For instructions, see “Storing Document Files and Web Links” on page 82.

Server Restarts
Whenever you restart your SMS 4.0 server computer (for example, for SMS updates or
Windows OS updates), you must follow these steps:
1. Notify all SMS 4.0 remote users to shut down their SMS 4.0 browser connections.
2. After all browser connections are shut down, restart the SMS 4.0 server computer.
3. The remote users can reconnect to the server.
If the server computer restarts unexpectedly before clients can shut down their SMS 4.0
sessions (for example, unexpected power outages), all clients must still shut down their
browsers. You must manually restart the server computer after all clients have shut down.

8
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New Installations
This chapter explains how to install the following Microsoft tools:

• Internet Information Services (IIS)
• Terminal Server and Terminal Services
• Active Server Pages (ASP) and ASP.Net
There are also instructions for using the Launchpad to install SMS 4.0 and add-on
products.
Before you begin, ensure that you have all of the prerequisites listed in “Prerequisites” on
page 3, and that you have installed and activated IIS and ASP.Net (and Terminal Server
or Terminal Services, if required); then follow the instructions to install SMS 4.0 for the first
time.
See the separate installation instructions for each product:

• “Installing System Manager PE” on page 16
• “Installing System Manager DL or System Manager SE” on page 24
Note
After you begin any of these launchpad installations, you should complete all of the launchpad
steps before you click FINISH. If you click FINISH before you are instructed, you see a
message telling you that you have not completed the installation. This message displays each
time that you restart the computer (until you complete all steps in the launchpad process).

SMS Licensing Requirements
Each SMS 4.0 product provides an SMS client access license (SMS CAL). These licenses
permit a specified number of simultaneous browser connections. You can purchase
additional licenses, providing more simultaneous connections. The SMS CAL
requirements are as follows:
System Manager DL and System Manager SE:
The SMS CAL permits only one browser connection. You can purchase an optional
product, WebXTR, that offers five additional simultaneous browser connections.
System Manager PE:
The SMS CAL permits ten simultaneous remote browser connections. You can purchase
additional licenses (each purchase provides an additional five remote browser
connections).
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Installing IIS, ASP, ASP.Net, MSMQ, and Terminal Server/Terminal Services
Internet Information Services (IIS) enables SMS 4.0 to serve web pages to its browser
clients. You must install IIS on the SMS 4.0 server computer BEFORE you run the SMS 4.0
installation.

Active Server Pages (ASP) and Active Server Pages for .Net Framework (ASP.Net)
are two Microsoft products. They provide rich web-client data to system users when the
SMS server is installed.

• In Windows 2000 Professional, Windows 2000 Server, and Windows XP: ASP is
automatically installed and enabled when IIS is installed. ASP.Net is installed and
enabled during the SMS Launchpad installation.

• In Windows Server 2003: You install ASP, ASP.Net, and IIS simultaneously; however,
you must enable ASP.Net separately.
Microsoft Message Queuing component (MSMQ) is used in the Advanced Reports
feature. You must install MSMQ on Windows XP, Windows 2000, and Windows Server
2003 operating systems before you install SMS.
Terminal Server and Terminal Services are Microsoft components that are required for
accessing the SMS Setup Utility, via the browser, from a remote computer. Only System
Manager PE supports this remote browser connection. You will install Terminal Server or
Terminal Services on the Windows 2000 Server and Windows Server 2003 operating
systems. After installation on one of these operating systems, you must contact Microsoft
to purchase all applicable server and client licensing components.

Windows 2000 Professional
1. Insert the Windows 2000 installation CD in the computer’s CD-ROM drive.
2. Click Start > Settings > Control Panel > Add/Remove Programs. On the left side of the
Add/Remove Programs window, click Add/Remove Windows Components.
3. When the Windows Components Wizard window displays, check:
— Internet Information Services (IIS)
— Message Queuing Services
4. Click Next.
Progress messages display while the updates are being made.
5. When the process is complete, click Finish; close the Add or Remove Programs screen.

Windows XP
1. Insert the Windows XP installation CD in the computer’s CD-ROM drive.
2. Click Start > Control Panel > Add or Remove Programs. On the left side of the
Add/Remove Programs window, click Add/Remove Windows Components.
3. When the Windows Components Wizard screen displays, check:
— Internet Information Services (IIS)
— Message Queuing Services
4. Click Next.
Progress messages display while the updates are being made.
5. When the process is complete, click Finish; close the Add or Remove Programs screen.

10
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Windows 2000 Server/Windows 2000 Advanced Server
1. Insert the Windows 2000 installation CD in the computer’s CD-ROM drive.
2. Click Start > Settings > Control Panel. Double click Add/Remove Programs. On the left
side of the Add/Remove Programs screen, click Add/Remove Windows Components.
3. When the Windows Components Wizard screen displays, check:
— Internet Information Services (IIS)
— Message Queuing Services
— Terminal Services
4. Click Next.
5. At the Terminal Services Setup screen, check “Application Server mode.” Click Next.
6. At the next screen, check “Permissions compatible with Terminal Server 4.0 Users.”
Click Next.
7. If a screen displays with a list of applications that may not work after installation, make
a note of these applications (you may need to reinstall them later). Click Next.
Progress messages display while the updates are being made.
8. When the process is complete, click Finish; close the Add or Remove Programs screen.

Note
After Terminal Services is installed, you must activate its Microsoft license. Directions for
purchasing licensing components are on the Microsoft website (www.Microsoft.com). During
the trial period that begins at installation, you have a temporary Terminal Services Client
Access License (TSCAL) that provides remote browser access to SMS Setup. If you have not
activated the license server by the end of this period, no remote client will be able to view SMS
Setup.

Windows Server 2003
1. Insert the Windows 2003 installation CD in the computer’s CD-ROM drive.
2. Click Start > Control Panel. Double-click Add or Remove Programs. On the left side of
the Add or Remove Programs window, click Add/Remove Windows Components.
3. When the Windows Components Wizard screen displays, check Application Server,
then click Details.
4. When the Application Server screen displays, check the following items (do not
change any other items):
— Application Server Console
— ASP.NET
— Enable Network COM+ Access
— Internet Information Services (IIS)
— Message Queuing
5. Click OK.
6. At the Windows Components Wizard screen, check Terminal Server.
7. At the Configuration Warning screen, click Yes, then click Next.
8. When the Terminal Server Setup screen displays, read the information on the screen
and click Next.
© 2006 Schneider Electric All Rights Reserved
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9. At the next screen, check Full (default). Click Next.
Progress bars display while the components are installed and configured.
10. When the Windows Components Wizard screen displays, click Finish. Close the Add
or Remove Programs screen.
ASP, ASP.Net, IIS, MSMQ, and Terminal Server are all installed. Follow the steps in the
next section to enable ASP.Net.

Note
After Terminal Server is installed, you must activate its Microsoft license. Directions for
purchasing licensing components are on the Microsoft website (www.Microsoft.com). During
the trial period that begins at installation, you have a temporary Terminal Server Client Access
License (TSCAL) that provides remote browser access to SMS Setup. If you have not activated
the license server by the end of this period, no remote client will be able to view SMS Setup.

Enabling ASP.Net on Windows Server 2003
After you have installed ASP, ASP.Net, and IIS on the Windows 2003 Server, you must
enable ASP.Net. Follow these steps:
1. Click Start > Control Panel. Double-click Administrative Tools. Double-click Internet
Information Services (IIS) Manager.
The Internet Information Services (IIS) Manager screen displays.
2. From the tree view (left-hand pane of the screen), click the “+” next to the name of the
local computer. Highlight Web Service Extensions.
The screen displays Web Service Extensions details:.

3. In the right-hand pane, check the status of Active Server Pages. If it is prohibited,
highlight the item name, and click Allow.
The status changes to Allowed.
4. Close the Internet Information Services (IIS) Manager screen.
NOTE: Verify that the ASP.NET status is also Allowed. If not, follow steps 3 and 4 for
ASP.NET.
ASP.Net is now enabled.

12
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Special Terminal Services Settings
After you complete the SMS installation on any server operating system (Windows 2000
Server/Windows Server 2003), you must make some changes to the Terminal Services
configuration. The following paragraphs describe the changes and the locations where
they are to be made. All of these settings are made in Terminal Services Configuration.
1. To begin, open the Administrative Tools screen, then click Terminal Services
Configuration to display the Terminal Services Configuration screen.
2. Highlight the Connections folder in the left pane of the Terminal Services Configuration
screen. From the right pane, right-click RDP/TCP and select Properties.
The RDP-TCP Properties screen displays.
Override User Settings
3. Click the Sessions tab:

4. Check the second “Override User Settings” box. Then select “End session.” Click
Apply. These settings are necessary; they ensure that the SMS Setup client
connections are properly closed when the browser is closed.

Note
If you do not check these boxes, memory usage will continue to increase, which could result in
severe performance problems.

© 2006 Schneider Electric All Rights Reserved
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Initial Program Settings
5. Click the Environment tab:

6. Make the following changes to this tab:
— Check the box “Override settings from user profile ... .”
— In the Program path and file name field, enter the SMS installation directory,
followed by \Bin\SMSSetupUtilTS.exe. For example, if the installation directory is
on your C drive, it would read:
C:\POWERLOGIC\SMS\Bin\SMSSetupUtilTS.exe

• In the Start in field, enter the SMS installation directory, followed by \Bin. Click Apply.
For example, if the installation directory is on your C drive, it would read:
C:\POWERLOGIC\SMS\bin
These settings cause remote computers to use the Terminal Services version of
the SMS Setup client.

Note
Do not use the full client version, (SMSSetupUtil.exe), which can result in severe performance
problems.

Optional Windows Logon Bypass
7. Click the Logon Settings tab):

14
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This option allows you to maintain one of two security levels, for users who are accessing
the SMS Setup client via the browser.
The default setting (“Use client-provided logon information”), offers greater security. It
requires all users to log into Windows before they can establish a browser connection as a
SMS Setup client.
The alternate setting (“Always use the following logon information”) lets you establish a
custom Windows account, which will be used as a default every time a user connects as
SMS Setup client through the browser. Although users will not be prompted for a Windows
user account when they access SMS, they will be prompted for their SMS user ID and
password.
If you check the “Always prompt for password” box, users will not be prompted for a
Windows user account; however, they must enter the associated password for the default
account.
In order to bypass Windows logon, check the box “Always use the following logon
information.” Enter a valid Windows user ID, domain, and password.
Remember that you must contact Microsoft to purchase all applicable server and client
licensing components for Terminal Server.

Run Windows Update
After IIS and ASP are installed and ASP is enabled, you need to run the Microsoft
Windows Update option on the Microsoft website. This ensures that the most recent
updates are applied for your operating system.

© 2006 Schneider Electric All Rights Reserved
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Installing System Manager PE
Follow these instructions to install System Manager PE on Windows Server
2000/Advanced Server 2000, Windows 2003 Server, or Windows XP. When there are
differences between the installs, you will see notes explaining the procedure for your
operating system or SMS product.
1. Insert the Install Launchpad disk in the CD-ROM drive of the SMS 4.0 server
computer.
If you have disabled your computer’s autorun feature, you will need to launch the
installation manually. To do this, click Start > Run, then browse to locate the CD
named LP_SMSPE40_1.
Double-click setup.exe. At the Run screen, click OK.
If you are installing on a computer that has Terminal Services or Terminal Server
installed (typically, Windows 2000 Server or Windows Server 2003), the Terminal
Server Install Failure screen displays.
2. Open the Control Panel and click Add/Remove Programs
3. At the Add/Remove Programs screen, click Add New Programs.
4. At the next screen, check CD or Floppy, then click Next.
5. At the Run Installation Program screen, browse to the CD-ROM drive.
6. At the Browse screen, select setup.exe; then click Open.
7. When the Run Installation Program displays again, click Next.
If you have not yet installed required components, they will be listed on the Launchpad
Prerequisites screen:
— The components that are listed must be installed before you can continue the
installation. Click Next to exit the install; then, install the prerequisites. See
“Prerequisites” on page 3 for installation instructions.
NOTE: If you see Windows Script Host (WSH) v 5.6 in the list, you need to
download and install this component. Download the Windows Script Host 5.6 file
from the Microsoft website. Double-click the .exe file to install it. Follow the onscreen instructions.
After all prerequisites are installed, you can restart the installation. After you insert the
installation CD, the Welcome screen displays. Click Next.
The System Manager Software License Agreement screen displays.
8. If you want to print a copy of license text, click Print. The text prints at the computer’s
default printer.
Before you continue, read the license agreement to be sure you accept its terms. To
continue the installation, click Yes. To terminate the installation, click No.
9. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.

16
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After the computer restarts, the Launchpad screen displays:

NOTE: If you are installing SMS on a Windows Server 2003 operating system, the first
box is checked. Skip “Installing .NET Framework v1.1 SP 1” on page 18.

Installing .NET Framework
10. Click the .NET Framework v 1.1 button.
11. When prompted to insert the Components CD, remove the Install Launchpad CD and
insert the Components CD. Browse to E:\DotNet Framework v1.1\dotnetfx1_1.exe
(where E is the name of your CD drive).
12. Click OK.
13. When prompted whether you would like to install .NET Framework, click Yes.
A progress bar displays, followed by the .NET Framework License Agreement screen.
14. If you want to print a copy of the text, click Print; the text prints at the default printer.
Click the “I agree” radio button, then click Install.
A progress bar displays, followed by a message telling you that .NET Framework
installation is complete.
15. Click OK.
After a series of verification screens, the Launchpad displays:

© 2006 Schneider Electric All Rights Reserved
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Installing .NET Framework v1.1 SP 1
16. Click the .NET Framework v1.1 SP1 button.
17. When prompted to insert the Components disk, remove the Install Launchpad disk and
insert the Components disk in the CD-ROM drive.
18. Browse to the appropriate folder on the CD:
Windows Server 2003: Browse to DotNet Framework v1.1 > SP1; then click:
en_dotnet_framework_1_1_sp1_w2k3.exe
Windows 2000 Server or Windows XP: Browse to DotNet Framework v1.1 > SP1;
then click:
en_dotnet_framework_1_1_sp1.exe
19. When prompted whether you want to install .NET Framework Service Pack 1, click
Yes.
20. When the license agreement screen displays, read the license text to ensure that you
agree with its terms. If you want to print a copy of the text, click View EULA for printing;
the text prints at the default printer.
To continue with the install, click the “I accept” radio button.
A message displays telling you that certain services will be stopped and then restarted.
21. Click Continue.
22. When installation is complete, a message tells you that it is “completing the Windows
Server KB867460 Setup Wizard.” Click Finish.
The Launchpad screen displays:

Installing SQL 2000
23. Click the MSSQL2000 button.
24. Follow the correct step for the operating system you are using:
Windows 2000 Server or Windows Server 2003: When prompted to insert the
SQL2K Standard CD, remove the Components disk and insert the SQL2K Standard
disk in the CD-ROM drive.
Windows XP: When prompted to insert the SQL2K Personal CD, remove the
Components disk and insert the SQL2K Personal disk in the CD-ROM drive.
25. Allow the CD to completely load, then click OK. Click Next at the InstallShield Wizard
Welcome screen.

18
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The Microsoft SQL Desktop license agreement screen displays.
26. If you want to print a copy of the license text, click Print; the text prints at the default
printer. To continue with the install, click Yes.
The Select a Drive screen displays.
27. Browse to choose a location for SQL desktop, or accept the default C drive. Click Next.
The Ready to Install the Program screen displays.
28. Click Install.
Informational messages display while SQL is being installed. This will take several
minutes.
When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays.

Installing System Manager 4.0
29. Click the System Manager Professional 4.0 button.
30. When prompted to insert the System Manager PE CD, remove the SQL2K disk and
insert the System Manager PE disk in the CD-ROM drive.
31. Allow the CD to completely load, then click OK.
32. When the Welcome screen displays, click Next.
The SMS License Agreement dialog displays.
33. To print a copy of the license text, click Print; the text prints at the default printer. Read
the license agreement to be sure you accept its terms. To continue the installation,
click Yes. To terminate the installation, click No.
The Customer Information screen displays.
34. Enter a user name and company name. This is simply to register the software. The
user name does not need to match any other SMS or Windows information). Enter the
serial number, which is found on the CD case and on a card packed inside the
software box. Click Next.
The Select a Drive screen displays.
35. Select the location for installing SMS. It is recommended that you accept the default:
C:\POWERLOGIC\SMS. Click Next.
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The SMS Account Setup screen displays:

36. You must add one level 1 (administrator) account for SMS. You will enter the user
name and password when you log on to SMS, both at SMS Setup and through the
browser. This is not a Windows password.
For information about adding additional SMS user accounts, and for the system
features that are available at each level, see the SMS Setup Utility online help file.
After you type the user account information, click Next.
37. When the Ready to Install the Program screen displays, click Install.
Informational messages display while files are being installed and updated. This can
take several minutes.
38. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays.

Installing Information Manager
39. Click the Information Manager button.
40. When prompted to insert the Information Manager CD, remove the System Manager
PE disk and insert the Information Manager disk in the CD-ROM drive.
41. Allow the CD to completely load, then click OK.
The Information Manager License Agreement dialog displays.
42. Before you continue, read the license agreement to be sure you accept its terms. To
continue the installation, click Yes. To terminate the installation, click No.
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Some installation messages display, followed by the Windows Account Information
screen (this account will be used to schedule reports; make a note of the account and
password that you enter for future use):

43. Enter a Windows Administrator account and password, and confirm the password;
then click OK.
44. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays:

45. Click FINISH.

Running SMS as a Windows Service
The About the SMS Account Selection Dialog screen displays. This screen describes
the procedure for determining whether SMS will run as a Windows service.
46. Read this information; then click Next.
A message displays asking if you have added the account to the IIS_WPG group.
47. If the account you will use is not in the IIS_WPG group, click No, and add the account
to IIS_WPG; then return to this screen; you do not need to stop the install procedure.
For instructions, see “Prerequisites” on page 3.
If the account is in the IIS_WPG, click Yes.
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The Run Mode screen displays:

48. On this screen, you choose whether you will run SMS as a Windows service. When
you run SMS as a service, the SMS server automatically restarts every time the server
computer is restarted. To ensure that data is always available to remote browsers, we
strongly recommend that you run SMS as a service.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows administrator account (or select the account from the list in the box).
The account cannot have a blank password: enter the account’s password, then retype
the password to verify it. This account is used to synchronize the Windows account
with SMS components.
For Cross-Language Installations: If you are running SMS on an operating system
that does not use the same language (such as French SMS on an English operating
system), you need to enter the administrator account that you have specified for this
purpose (see “Cross-Language Installations” on page 7).
If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is a member of the IIS Worker
Process Group (IIS_WPG group). For instructions on adding the account to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS install to
add the account to the IIS_WPG.
49. After you type the account and password, click Next.
Several progress messages display, which can take several minutes.
If you have not previously changed the SQL Administration account password, a
message displays telling you that the account password is blank, and that it may pose
a security risk.
50. At this prompt, we recommend that you click Yes, which allows setup to change the
password to “DBMaster.” If you want to change the password later, use SQL
Enterprise Manager.
If there are any remaining components that you have not installed (for example, SQL
Service Pack 3 or Terminal Server), the Post Installation Configuration screen
displays.
51. Note any components that you need to install, and complete these installations after
the SMS installation is complete. Click Next.
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When setup is complete, the Registration Form dialog displays:

52. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers ten SMS 4.0 client access licenses, is printed on the software
box and on a card in your software package. To register your SMS software, click one
of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the form. Close the registration form window
and the Registration window. Fax or mail the completed form to your Schneider
Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS.
53. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
SMS is now installed. Remember to install any missing components. See “Installing SQL
Service Pack 3” on page 51 for instructions on installing SQL Service Pack 3.
If you need to install optional products, such as GFX, see the instruction sheet that you
received with the installation CD.
For help in starting SMS, see “Accessing SMS 4.0” on page 75.
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Installing System Manager DL or System Manager SE
Note
Except for names at the top of screens, the System Manager DL and System Manager SE
installs are the same. These instructions use screen captures for System Manager SE.

1. Insert the Install Launchpad disk in the CD-ROM drive of the SMS 4.0 server
computer.
If you have disabled your computer’s autorun feature, you will need to launch the
installation manually. To do this, click Start > Run, then browse to locate the CD
named LP_SMSPE40_1.
Double-click setup.exe. At the Run screen, click OK.
If you are installing on a computer that has Terminal Services or Terminal Server
installed (typically Windows 2000 Server or Windows Server 2003), the Terminal
Server Install Failure screen displays.
2. Open the Control Panel and click Add/Remove Programs
3. At the Add/Remove Programs screen, click Add New Programs.
4. At the next screen, check CD or Floppy, then click Next.
5. At the Run Installation Program screen, browse to the CD-ROM drive.
6. At the Browse screen, select setup.exe; then click Open.
7. When the Run Installation Program displays again, click Next.
If you have not yet installed required components, they will be listed on the Launchpad
Prerequisites screen:
— The components that are listed must be installed before you can continue the
installation. Click Next to exit the install; then, install the prerequisites. See
“Prerequisites” on page 3 for installation instructions.
If you see Windows Script Host (WSH) v 5.6 in the list, you need to download and
install this component. Download the Windows Script Host 5.6 file from the
Microsoft website. Double-click the .exe file to install it. Follow the on-screen
instructions.
After all prerequisites are installed, you can restart the installation. After you insert the
installation CD, the Welcome screen displays. Click Next.
The System Manager Software License Agreement screen displays.
8. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer.
To continue the installation, click Yes. To terminate the installation, click No.
9. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
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After the computer restarts, the Launchpad screen displays:

If a component is already installed, a red check appears in the Installed column; you
do not need to re-install this component. These instructions assume that none of the
components are installed, and that you will install them in the order given.

Installing .NET Framework
10. Click the .NET Framework v 1.1 button.
11. When prompted to insert the Components CD, remove the Install Launchpad CD and
insert the Components CD. Browse to E:\DotNet Framework v1.1\dotnetfx1_1.exe
(where E is the name of your CD drive).
12. Click OK.
13. When prompted whether you would like to install.NET Framework, click Yes.
A progress bar displays, followed by the .NET Framework License Agreement screen.
14. If you want to print a copy of the text, click Print; the text prints at the default printer.
Click the “I agree” radio button, then click Install.
A progress bar displays, followed by a message telling you that .NET Framework
installation is complete.
15. Click OK.
After a series of verification screens, the Launchpad displays again (note that a red
check appears next to .NET Framework v1.1, indicating that it was successfully
installed).
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Installing .NET Framework v1.1 SP 1
16. Click the.NET Framework v1.1 SP1 button.
17. Browse to E:\DotNet Framework v1.1\dotnetfx1_1.exe (where E is the name of your
CD drive). Double-click dotnetfx1_1.exe.
18. When prompted whether you want to install .NET Framework Service Pack 1, click
Yes.
The license agreement screen displays.
19. If you want to print a copy of the text, click View EULA for printing; the text prints at the
default printer. Click the “I accept” radio button.
20. When installation is complete, click OK.
If you are prompted to restart, do so now. At the Windows login screen, you must log
in with a Windows Administrator password.
The Launchpad screen displays:

Installing MSDE 2000
21. Click the MSDE 2000 button.
22. When prompted to insert the MSDE 2000 CD, remove the Components disk and insert
the MSDE 2000 disk. Browse to E:\.MSDE\MSDE2000\setup.exe (where E is the
name of your CD drive).
The Microsoft SQL license agreement screen displays.
23. Click the “I accept the terms of the license agreement” radio button; then click Next.
The SQL Desktop Destination Folder screen displays.
24. Browse to choose a location for SQL desktop, or accept the default C drive. Click Next.
25. When the Start Copying Files screen displays, click Next.
Installing the SQL files takes several minutes.
26. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
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After the computer restarts, the Launchpad screen displays.

Installing System Manager 4.0
27. Click the System Manager button.
28. When prompted to insert the System Manager 4.0 CD, remove the Components disk
and insert the System Manager SE (or System Manager DL) disk in the CD-ROM
drive.
29. Allow the CD to completely load, then click OK.
30. When the Welcome screen displays, click Next.
The SMS License Agreement dialog displays.
31. Read the license agreement to be sure you accept its terms. If you want to print a copy
of the text, click Print; the text prints at the default printer. To continue the installation,
click Yes. To terminate the installation, click No.
The Customer Information screen displays.
32. Enter a user name and company name. This is simply to register the software. The
user name does not need to match any other SMS or Windows information). Enter the
serial number, which is found on the CD case and on a card packed inside the
software box. Click Next.
The Destination Location screen displays.
33. Select the location for installing SMS. It is recommended that you accept the default:
C:\POWERLOGIC\SMS. Click Next.
The SMS Account Setup screen displays:

34. You must add one level 1 (administrator) account for SMS. You will use this user name
and password when you log on to SMS, both at SMS Setup and through the browser.
This is not a Windows password.
© 2006 Schneider Electric All Rights Reserved
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For information about adding additional SMS user accounts, and for the system
features that are available at each level, see the SMS Setup Utility online help file.
After you type the user account information, click Next.

Running SMS as a Windows Service
The About the SMS Account Selection screen displays.
35. This screen describes the procedure for determining whether SMS will run as a
Windows service. Read this information; then click Next.
The Run Mode screen displays:

36. On this screen, you choose whether you will run SMS as a Windows service. When
you run SMS as a service, the SMS server automatically restarts every time the server
computer is restarted. To ensure that data is always available to remote browsers, we
strongly recommend that you run SMS as a service.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows administrator account (or select an account from the list in the box).
The account cannot have a blank password: enter the account’s password, then retype
the password to verify it. This account is used to synchronize the Windows account
with SMS components.
For Cross-Language Installations: If you are running SMS on an operating system
that does not use the same language (such as French SMS on an English operating
system), you need to enter the administrator account that you have specified for this
purpose (see “Cross-Language Installations” on page 7).
If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is also a member of the IIS
Worker Process Group (IIS_WPG group). For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS install to
add the account to the IIS_WPG.
37. After you type the account and password, click Next.
38. When the Start Copying screen displays, click Next.
Several progress messages display, which can take several minutes.
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When setup is complete, the System Manager Software Registration Form dialog
displays:

39. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers one SMS 4.0 client access license (browser access), is
printed on the CD case and on a card that is in your software package.
To increase the number of simultaneous browser connections, you can purchase an
optional product called WebXTR. See your Schneider Electric representative for
assistance.
40. To register your SMS 4.0 software, click one of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window, and continue with
step 38.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the completed form. Close the registration
form window and the Registration window. Fax or mail the completed form to your
local Schneider Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS. >
Registration.
41. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
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After the computer restarts, the Launchpad screen displays:.

Installing Information Manager
42. Click the Information Manager button.
43. When prompted to insert the Information Manager CD, remove the System Manager
4.0 disk and insert the Information Manager disk in the CD-ROM drive.
44. Allow the CD to completely load, then click OK.
The Information Manager License Agreement dialog displays.
45. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer. To
continue the installation, click Yes. To terminate the installation, click No.
Some installation messages display, followed by the Windows Account Information
screen. This account will be used to schedule reports; make a note of the account and
password that you enter for future use. This could be the same Windows account that
was set up in step 30.

46. Enter a Windows Administrator account and password, and confirm the password;
then click OK.
47. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
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After the computer restarts, the Launchpad screen displays:.

48. Click FINISH.
49. When prompted to insert the Install Launchpad CD, remove the Information Manager
disk and insert the Install Launchpad disk in the CD-ROM drive.
50. Allow the CD to completely load, then click OK.
The About the SMS Account Selection screen displays. This screen describes the
procedure for determining whether SMS will run as a Windows service.
51. Read this information; then click Next.
The Run Mode screen displays:

52. On this screen, you choose whether you will run SMS as a Windows service. To
ensure that data is always available to remote browsers, we strongly recommend that
you run SMS as a service. When you run SMS as a service, the SMS server
automatically restarts every time the server computer is restarted.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows administrator or power user account (or select the account from the
list in the box). The account cannot have a blank password: enter the account’s
password, then retype the password to verify it. This account is used to synchronize
the Windows account with SMS components.
If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is also a member of the IIS
Worker Process Group (IIS_WPG group). For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS install to
add the user to the IIS_WPG.
53. After you type the account and password, click Next.
Several progress messages display, which can take several minutes.
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A screen may display with a question about the SQL Administration account:

54. This screen displays if your SQL administrator account has a blank password. SMS
can change the password to “DBMaster.” If you want the blank password changed to
DBMaster, click Yes. If you do not want DBMaster as the password, click No (to
change the password later, see the Microsoft website for help).
If there are missing components (such as Terminal Services or SQL Service Pack 3),
the Post Installation Configuration screen displays:

55. Note the missing items. After you finish installation, be sure to install any missing
items. Click Next.
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The System Manager Software Registration Form dialog displays:

56. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers one SMS 4.0 client access license (browser access), is
printed on the CD case and on a card that is in your software package.
To increase the number of simultaneous browser connections, you can purchase an
optional product called WebXTR. See your Schneider Electric representative for
assistance.
57. To register your SMS 4.0 software, click one of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the completed form. Close the registration
form window and the Registration window. Fax or mail the completed form to your
local Schneider Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS. >
Registration.
58. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
SMS is now installed. Remember to install any missing components. See “Installing SQL
Service Pack 3” on page 51 for instructions on installing SQL Service Pack 3.
If you need to install optional products, such as GFX, see the instruction sheet that you
received with the installation CD.
For help in starting SMS, see “Accessing SMS 4.0” on page 75.

Optional Installs
If you have purchased optional add-on software (for example, GFX or WebXTR), you can
install them now. Use the CD and installation instructions provided with the add-on
product.
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Reinstalling Terminal Services
If your SMS server is the using Microsoft 2003 Server operating system AND Terminal
Services was installed on the server computer before you installed SMS, you had to
uninstall it. Now is the time to re-install Terminal Services:
1. Click Start > Control Panel > Add or Remove Programs.
2. At the Add or Remove Components screen, click Add/Remove Windows Components.
3. At the Windows Components window, check Terminal Server.

Uninstalling and Reinstalling SMS 4.0
Never uninstall or reinstall MSDE or SQL. Doing so could destroy the data in your
database.

When Terminal Server or Terminal Services is Installed
When you want to uninstall SMS, and the SMS server computer has either Terminal
Server or Terminal Services installed on it, contact your local Schneider Electric
representative for technical assistance.

When Terminal Server or Terminal Services is not Installed
Use this procedure only when Terminal Server or Terminal Services are not installed on
the server computer:
To uninstall SMS 4.0 and its components, do the following:
1. Have all users close out of their browser sessions.
2. Disconnect the network cable from the server computer (to ensure that no one
connects from a remote computer while you are uninstalling).
3. Shut down SMS Setup and the SMS Configuration Utility. If you are not running the
PowerLogic Network Server as a Windows service, close it, too.
4. Browse to this location on the server computer’s hard drive:
5. c:\Program Files\Common Files\Square D Shared\Launchpad\Uninstall.
6. Double-click setup.exe.
7. If you have changed the SQL password since SMS was installed, the SQL Account
Request screen displays. Enter the new password, then click Next.
8. When the Uninstall screen displays, click Next.
9. When the Directories to Delete screen displays, click Next.
10. When the Begin Uninstall screen displays, click Next.
11. Several messages display while the SMS files are being uninstalled. Then the Reboot
Required screen displays.
12. Before you restart the computer, click on the Windows Explorer window to make it live,
then close it.
13. Click OK at the Reboot Required screen.
14. After you complete the uninstall procedure, reconnect the network cable to the server
computer.
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If you only want to reinstall the Advanced Reports add-on, see “Reinstalling the Advanced
Reports add-on” on page 73.
To reinstall all of SMS 4.0.1 and its components, do the following:
1. Have all users close out of their browser sessions.
2. Disconnect the network cable from the server computer (to ensure that no one
connects from a remote computer while you are reinstalling).
3. Shut down SMS Setup and the SMS Configuration Utility. If you are not running the
PowerLogic Network Server as a Windows service, close it, too.
4. Insert the Install Launchpad disk in the CD-ROM drive of the server computer.
5. Using the Launchpad, install the appropriate components (if .NET Framework was not
uninstalled, skip the .NET Framework steps).
NOTE: Remember: Do NOT reinstall MSDE; the data in your database could be
overwritten.
6. If you have purchased the GFX add-on software, reinstall it from the CD that was
shipped with your GFX order.
7. Install the add-on:
— Go to Add/Remove Programs; click Add New Programs.
— Click CD or Floppy. Use the wizard to select and set up the product(s) you are
adding.
8. Reconnect the network cable and restart the computer.
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Upgrade Installations
This chapter explains how to upgrade from either SMS version 3.3.2.3 or SMS version 4.0
to SMS version 4.0, Service Update 1 (SMS 4.0 SU1).
There are also instructions for installing additional products, such as SQL Service Pack 3,
and instructions for uninstalling or reinstalling SMS.
Before you begin, ensure that you have all of the prerequisites listed in “Prerequisites” on
page 3, and that you have installed and activated IIS and ASP.Net; then follow the steps
below to upgrade to SMS 4.0 SU1.

Note
Except for names at the top of screens, the System Manager DL and System Manager SE
installs are exactly the same. These instructions use screen captures for System Manager SE.

SMS 4.0 to SMS 4.0 SU1
Follow these steps to upgrade SMS DL or SE, version 4.0 to SMS DL or SE, version 4.0.1.
1. Use the Database Services function in SMS to back up the SMS history database.
2. Shut down SMS.
3. Insert the Install Launchpad disk in the CD-ROM drive of the SMS 4.0 server
computer.
If you have disabled your computer’s autorun feature, you will need to launch the
installation manually. To do this, click Start > Run, then browse to locate the CD
named LP_SMSSEU40_1 or LP_SMSDLU40_1.
Double-click setup.exe. At the Run screen, click OK.
If you are installing on a computer that has Terminal Services or Terminal Server
installed (typically Windows 2000 Server or Windows Server 2003), the Terminal
Server Install Failure screen displays.
4. Open the Control Panel and click Add/Remove Programs
5. At the Add/Remove Programs screen, click Add New Programs.
6. At the next screen, check CD or Floppy, then click Next.
7. At the Run Installation Program screen, browse to the CD-ROM drive.
8. At the Browse screen, select setup.exe; then click Open.
9. When the Run Installation Program displays again, click Next.
If you have not yet installed required components, they will be listed on the Launchpad
Prerequisites screen:
— The components that are listed must be installed before you can continue the
installation. Make a note of these components, then click Next to exit the install.
Install the prerequisites. See “Prerequisites” on page 3 for installation instructions.
If you see Windows Script Host (WSH) v 5.6 in the list, you need to download and
install this component. Download the Windows Script Host 5.6 file from the

© 2006 Schneider Electric All Rights Reserved

37

Upgrade Installations
SMS 4.0 to SMS 4.0 SU1

63220-060-228D1
05/2006

Microsoft website. Double-click the .exe file to install it. Follow the on-screen
instructions.
— After all prerequisites are installed, you can restart the installation. After you insert
the installation CD, the Welcome screen displays. Click Next.
The System Manager Software License Agreement screen displays.
10. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer.
To continue the installation, click Yes. To terminate the installation, click No.
11. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays:

All components have a red check (are installed) except for .NET Framework v1.1 SP1.

Installing .NET Framework V1.1 SP1
12. Click the .NET Framework v1.1 SP1 button.
13. When prompted to insert the Components CD, remove Launchpad Disk and insert
Components disk in the CD-ROM drive.
14. Click OK.
15. When prompted whether you would like to install .NET Framework, click Yes.
A progress bar displays, followed by the .NET Framework License Agreement screen.
16. If you want to print a copy of the text, click Print; the text prints at the default printer.
Click the “I agree” radio button, then click Install.
A progress bar displays, followed by a message telling you that .NET Framework
installation is complete.
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17. Click OK.
After a series of verification screens, the Launchpad displays again.

18. Click FINISH.

Running SMS as a Windows Service
After several update messages, the About the SMS Account Selection Dialog screen
displays. This screen describes the procedure for determining whether SMS will run as
a Windows service.
19. Read this information; then click Next.
A message displays asking if you have added the account to the IIS_WPG group. This
is done in the Computer Management directory.
20. If the account you will use is not in the IIS_WPG group, click No, and add the account
to IIS_WPG; then return to this screen; you do not need to stop the install procedure.
For instructions on adding a user to the IIS_WPG, see “Prerequisites” on page 3.
If the account is in the IIS_WPG, click Yes.
The Run Mode screen displays:

21. On this screen, you choose whether you will run SMS as a Windows service. To
ensure that data is always available to remote browsers, we strongly recommend that
you run SMS as a service. When you run SMS as a service, the SMS server
automatically restarts every time the server computer is restarted.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows administrator account (or select the account from the list in the box).
The account cannot have a blank password: enter the account’s password, then retype
the password to verify it. This account is used to synchronize the Windows account
with SMS components.
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For Cross-Language Installations: If you are running SMS on an operating system
that does not use the same language (such as French SMS on an English operating
system), you need to enter the administrator account that you have specified for this
purpose (see “Cross-Language Installations” on page 7).
. If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is also a member of the IIS
Worker Process Group (IIS_WPG group). For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS installation
to add the account to the IIS_WPG.
22. After you type the account and password, click Next.
A series of update messages display, which can take several minutes.
A screen may display with a question about the SQL Administration account:

23. This screen displays if your SQL administrator account has a blank password. SMS
can change the password to “DBMaster.” If you want the blank password changed to
DBMaster, click Yes. If you do not want DBMaster as the password, click No (to
change the password later, see the Microsoft website for help).
If there are missing components (such as Terminal Services or SQL Service Pack 3),
the Post Installation Configuration screen displays:

24. Note the missing items. After you finish installation, be sure to install any missing
items. Click Next.
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the System Manager Software Registration Form dialog displays:

25. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers one SMS 4.0 client access license (browser access), is
printed on the CD case and on a card that is in your software package.

Note
To increase the number of simultaneous browser connections, you can purchase an optional
product called WebXTR. See your Schneider Electric representative for assistance.

26. To register your SMS 4.0 software, click one of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the completed form. Close the registration
form window and the Registration window. Fax or mail the completed form to your
local Schneider Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS. >
Registration.
27. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
SMS is now installed. Remember to install any missing components. See “Installing SQL
Service Pack 3” on page 51 for instructions on installing SQL Service Pack 3.
If you need to install optional products, such as GFX, see the instruction sheet that you
received with the installation CD.
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Follow these steps to upgrade one of the following scenarios:
SMS 3.3.2.3 or Web3000, Phase 2 to SMS 4.0.1, PE
SMS1500 or PMX1500 to SMS 4.0.1, SE.
SMS121 to SMS 4.0.1, DL
All screen examples are for SMS SE.
1. Use the Database Services function in SMS to back up the SMS history database.
2. Shut down SMS.
3. Insert the Install Launchpad disk in the CD-ROM drive of the SMS 4.0 server
computer.
If you have disabled your computer’s autorun feature, you will need to launch the
installation manually. To do this, click Start > Run, then browse to locate the CD
named LP_SMSSEU40_1 (or LP_SMSDLU40_1 or LP_SMSPEU40_1).
Double-click setup.exe. At the Run screen, click OK.
If you are installing on a computer that has Terminal Services or Terminal Server
installed (typically Windows 2000 Server or Windows Server 2003), the Terminal
Server Install Failure screen displays.
4. Open the Control Panel and click Add/Remove Programs
5. At the Add/Remove Programs screen, click Add New Programs.
6. At the next screen, check CD or Floppy, then click Next.
7. At the Run Installation Program screen, browse to the CD-ROM drive.
8. At the Browse screen, select setup.exe; then click Open.
9. When the Run Installation Program displays again, click Next.
If you have not yet installed required components, they will be listed on the Launchpad
Prerequisites screen:
— The components that are listed must be installed before you can continue the
installation. Make a note of these components, then click Next to exit the install.
Install the prerequisites. See “Prerequisites” on page 3 for installation instructions.
If you see Windows Script Host (WSH) v 5.6 in the list, you need to download and
install this component. Download the Windows Script Host 5.6 file from the
Microsoft website. Double-click the .exe file to install it. Follow the on-screen
instructions.
After all prerequisites are installed, you can restart the installation. After you insert the
installation CD, the Welcome screen displays. Click Next.
The System Manager Software License Agreement screen displays.
10. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer.
To continue the installation, click Yes. To terminate the installation, click No.
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11. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays:

12. If .NET Framework v1.1 has a red check next to it, see “Installing .NET Framework
v1.1 SP1” on page 43. Otherwise, click .NET Framework v1.1.
13. When prompted to insert the Components CD, remove the Install Launchpad CD and
insert the Components CD. Browse to E:\DotNet Framework v1.1\dotnetfx1_1.exe
(where E is the name of your CD drive).
14. When prompted whether you want to install the Microsoft .NET Framework 1.1
package, click Yes.
15. When the license agreement screen displays, read the license text to ensure that you
agree with its terms; then click “I agree” if you wish to continue.
16. When installation is complete, click OK.
After a series of verification screens, the Launchpad screen displays:

Installing .NET Framework v1.1 SP1
17. Click .NET Framework v1.1 SP1.
18. Browse to E:\DotNet Framework v1.1\dotnetfx1_1.exe (where E is the name of your
CD drive). Double-click dotnetfx1_1.exe.
19. When prompted whether you want to install .NET Framework v1.1 SP1, click OK.
The license agreement screen displays.
20. If you want to print a copy of the text, click View EULA for printing; the text prints at the
default printer. Click the “I accept” radio button.
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21. When installation is complete, click OK.
If you are prompted to restart, do so now. At the Windows login screen, you must log
in with a Windows Administrator password.
The Launchpad screen displays:

22. Click the System Manager 4.0 button.
23. When prompted to insert the System Manager 4.0 CD, remove the Components disk
and insert the System Manager SE (or System Manager DL or System Manager PE)
disk in the CD-ROM drive.
24. Allow the CD to completely load, then click OK.
25. When the Welcome screen displays, click Next.
The SMS License Agreement dialog displays.
26. Read the license agreement to be sure you accept its terms. If you want to print a copy
of the text, click Print; the text prints at the default printer. To continue the installation,
click Yes. To terminate the installation, click No.
The Destination Location screen displays.
27. Select the location for installing SMS. It is recommended that you accept the default:
C:\POWERLOGIC\SMS. Click Next.
If you have SMS IDs that have blank passwords, a message displays. All of the SMS
usernames listed on this screen have blank passwords, which SMS no longer allows.
For each username, the password will be changed to match the username. For
example, if an ID of JohnDoe has a blank password, the password will be changed to
JohnDoe.
28. Click Next. After installation, you can change the passwords in SMS Setup.

Running SMS as a Windows Service
The About the SMS Account Selection screen displays.
29. This screen describes the procedure for determining whether SMS will run as a
Windows service. Read this information; then click Next.
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The Run Mode screen displays:

30. On this screen, you choose whether you will run SMS as a Windows service. When
you run SMS as a service, the SMS server automatically restarts every time the server
computer is restarted. To ensure that data is always available to remote browsers, we
strongly recommend that you run SMS as a service.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows administrator account (or select an account from the list in the box).
The account cannot have a blank password: enter the account’s password, then retype
the password to verify it. This account is used to synchronize the Windows account
with SMS components.
For Cross-Language Installations: If you are running SMS on an operating system
that does not use the same language (such as French SMS on an English operating
system), you need to enter the administrator account that you have specified for this
purpose (see “Cross-Language Installations” on page 7).
If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is also a member of the IIS
Worker Process Group (IIS_WPG group). For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS installation
to add the account to the IIS_WPG.
31. After you type the account and password, click Next.
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32. When the Start Copying screen displays, click Next.
Several progress messages display, which can take several minutes.
When setup is complete, the System Manager Software Registration Form dialog
displays:

33. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers one SMS 4.0 client access license (browser access), is
printed on the CD case and on a card that is in your software package.
To increase the number of simultaneous browser connections, you can purchase an
optional product called WebXTR. See your Schneider Electric representative for
assistance.
34. To register your SMS 4.0 software, click one of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the completed form. Close the registration
form window and the Registration window. Fax or mail the completed form to your
local Schneider Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS. >
Registration.
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35. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays:

Installing Information Manager
36. Click the Information Manager button.
37. When prompted to insert the Information Manager CD, remove the System Manager
4.0 disk and insert the Information Manager disk in the CD-ROM drive.
38. Allow the CD to completely load, then click OK.
The Information Manager License Agreement dialog displays.
39. Before you continue, read the license agreement to be sure you accept its terms. To
continue the installation, click Yes. To terminate the installation, click No.
Some installation messages display, followed by the Windows Account Information
screen. This account will be used to schedule reports; make a note of the account and
password that you enter for future use.

40. Enter a Windows Administrator account and password, and confirm the password;
then click OK.

© 2006 Schneider Electric All Rights Reserved

47

Upgrade Installations
SMS 3.3.2.3 to SMS 4.0 SU1

63220-060-228D1
05/2006

41. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays:

42. Click FINISH.
The About the SMS Account Selection screen displays. This screen describes the
procedure for determining whether SMS will run as a Windows service.
43. Read this information; then click Next.
A message may display, asking if you have added the account to the IIS_WPG group.
44. If the account you will use is not in the IIS_WPG group, click No, and add the account
to IIS_WPG; then return to this screen. For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS installation
to add the account to the IIS_WPG.
If the account is in the IIS_WPG, click Yes.
The Run Mode screen displays:

45. On this screen, you choose whether you will run SMS as a Windows service. To
ensure that data is always available to remote browsers, we strongly recommend that
you run SMS as a service. When you run SMS as a service, the SMS server
automatically restarts every time the server computer is restarted.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows administrator or power user account (or select the account from the
list in the box). The account cannot have a blank password: enter the account’s
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password, then retype the password to verify it. This account is used to synchronize
the Windows account with SMS components.
If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is also a member of the IIS
Worker Process Group (IIS_WPG group). For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS installation
to add the account to the IIS_WPG.
46. After you type the account and password, click Next.
Several progress messages display, which can take several minutes.
A screen may display with a question about the SQL Administration account:

47. This screen displays if your SQL administrator account has a blank password. SMS
can change the password to “DBMaster.” If you want the blank password changed to
DBMaster, click Yes. If you do not want DBMaster as the password, click No (to
change the password later in System Manager PE, use SQL Enterprise Manager; in
System Manager SE and DL, see the Microsoft website).
If there are missing components (such as Terminal Services or SQL Service Pack 3),
the Post Installation Configuration screen displays:
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48. Note the missing items. After you finish installation, be sure to install any missing
items. Click Next.
The System Manager Software Registration Form dialog displays:

49. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers one SMS 4.0 client access license (browser access), is
printed on the CD case and on a card that is in your software package.
To increase the number of simultaneous browser connections, you can purchase an
optional product called WebXTR. See your Schneider Electric representative for
assistance.
50. To register your SMS 4.0 software, click one of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the completed form. Close the registration
form window and the Registration window. Fax or mail the completed form to your
local Schneider Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS. >
Registration.
51. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
SMS is now installed. Remember to install any missing components. If you need to install
SQL Service Pack 3, see “Installing SQL Service Pack 3” on page 51.
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Optional Installs
If you have purchased optional add-on software (for example, GFX or WebXTR), you can
install them now. Use the CD and installation instructions provided with the add-on
product.
You may have previously installed optional devices—such as a Sepam device, PM500, or
PM9C—before you began the SMS upgrade. If any of these devices were installed, you
should re-run the optional install for each device type now. This will ensure that all of the
device type updates are properly installed.

Ethernet Gateway
If you are using an Ethernet Gateway and you are moving SMS to a different computer,
you need to reinstall the Ethernet Gateway before you install SMS 4.0. The installation for
the Ethernet Gateway is in your SMS 3.3 installation set.

Installing SQL Service Pack 3
Microsoft issued SQL Service Pack 3 to defend against the “Slammer” virus. You need to
install SQL Service Pack 3 on any computer at which a SQL database is installed. There
are separate instructions for:

• SQL Standard or SQL Personal
• MSDE
Service Pack 3A Prerequisites
1. If you are running SMS on a Windows XP operating system, you need to upgrade the
operating system to Windows XP Service Pack 1 before running the SQL/MSDE
Service Pack 3. You can download the Windows XP Service Pack 1 from Microsoft’s
website at:
http://www.microsoft.com/WindowsXP/SP1
2. Make sure that you have enough free space to run this install. You need at least 400
MB of free space for this service pack installation.
If you have already installed SQL Service Pack 3 on the server computer, you can skip
these instructions, and go to “Optional Installs” on page 51. If you have not yet installed
SQL Service Pack 3 on your SMS server computer, choose the correct instructions for
your operating system:

SQL Service Pack 3 for SQL Standard or Personal
Use this install when you have SMS PE or SMS SE/Advanced Reports feature.
1. Insert the Components disk in the SMS Server computer’s CD-ROM drive.
2. Locate the setupSQL.exe file:
\MSSQL2000_SP3\sql2ksp3\x86\setup\setupsql.exe
3. Double-click setupSQL.exe .
4. At the Welcome screen, click Next.
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5. At the Software License Agreement screen, read the license information, then click
Yes.
6. At the Instance Name screen, be sure that the default instance name is the correct one
for this computer. If not, select the correct instance name from the dropdown list. Click
Next.
7. At the Connect to Server screen, choose “The SQL Server system administrator login
information (SQL Server authentication).” Then enter the password for the SQL “sa”
account on this computer. Click Next.
8. At the SQL Server 2000 Service Pack 3 Setup screen, check the box “Upgrade
Microsoft Search and apply SQL Server 2000 SP3.” Click Continue.
9. If the password on the previous screen was blank, the SA Password Warning screen.
For higher security on this computer, you should enter and confirm a password for the
SQL “sa” account. Be sure to note this new password for later use.
10. At the Error Reporting screen, read the information. Check “Automatically send fatal
reports to Microsoft” if you wish. Click OK.
11. At the Start Copying Files screen, click Next.
Progress messages display while the setup and installation are run. This could take
several minutes.
12. At the message telling you that you should back up your databases, click OK.
13. At the Setup Complete screen, click Finish.
If you have more than one instance of SQL Server on this computer, you must apply
the fix separately for each instance. Follow steps 3 through 13 for each instance. The
instances will be named “MSSQL$****” (where **** is the specific name of the
instance, for example sms1500). As you run the .exe file, you are prompted to select a
single instance. Be sure to run the patch for every instance on your computer.
14. After you install the service pack for all instances of the SQL server, you must restart
the computer.
15. Make sure that the SQL agent is set to automatic:
a. Display the SQL Server Service Manager box: click Start > Programs > Startup >
Service Manager.
b. In the Server box, the name must match the SMS server computer name and SMS
product: <computer name>\smsxxxx (where “<computer name>” is the name of the
server computer, and where smxxxx is the name of the SMS product: SMS3000,
SMS1500, PMX1500, or SMS121).
c. From the Services pull-down box, select SQL Server Agent.
d. Check the box named “Auto-start service when OS starts.”
e. Click Start/Continue.
f.

Close the SQL Server Service Manager box.

16. Restart the computer.
17. Go to Database Services to back up your entire database (Database Services is in the
SMS Setup Utility: Setup > Administrative > Database Services).
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SQL Service Pack 3 for MSDE
Use this install for all System Manager DL and System Manager SE without Advanced
Reports.
1. Insert the Components disk in the SMS Server computer’s CD-ROM drive.
2. From the MSSQL2000_SP3 folder on the Components disk, copy the folder called
sql2ksp3_msde. Place sql2ksp3_msde on the computer’s C drive.
3. Copy the file called Install_MSDE_SP3.exe from the CD (MSSQL2000_SP3 folder).
Place Install_MSDE_SP3 in sql2ksp3_msde on the computer’s hard drive.
4. From the computer’s hard drive, launch Install_MSDE_SP3.exe.
5. When prompted, choose the SQL instance that is installed on the computer. Enter the
user and password for that instance. Follow the remaining instructions to complete the
Service Pack 3 installation
If there are multiple SQL instances, repeat this step for each of them.
6. After you finish the SQL Service Pack 3 installation, go back to Database Services to
back up your entire database (Database Services is in the SMS Setup Utility: Setup >
Administrative > Database Services).
You are now ready to begin using SMS.

Additional SMS 4.0 Client Licenses
When you purchase System Manager DL or System Manager SE, you receive one SMS
4.0 client access license. This license permits one browser connection to SMS 4.0. You
can purchase an additional five licenses for a total of six simultaneous browser
connections.
When you purchase System Manager PE, you receive 10 client access licenses. You can
purchase additional licenses (in increments of five) to give you a total of 30 simultaneous
browser connections.
To order the extra licenses, go to www.powerlogic.com; or contact your Schneider Electric
representative.
When you receive the additional licenses, you must register them. To begin registration,
click Start > Programs > POWERLOGIC > DOCS. Follow the same registration process
that you followed when you installed SMS 4.0.

Installing Add-on Products after SMS 4.0 is Installed
When SMS 4.0 is already installed, follow the procedure below to install any add-on
products (for example, GFX or a Sepam device type) that you are using:
1. Disconnect the network cable to the SMS 4.0 server.
2. Restart the computer.
3. Install the add-on:
— Go to Add/Remove Programs; click Add New Programs.
— Click CD or Floppy. Use the wizard to select and set up the product(s) you are
adding.
4. Reconnect the network cable and restart the computer.
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Advanced Reports Add-On Installations
This chapter describes the procedure for installing the optional Advanced Reports add-on
product.
Use these upgrade installations to upgrade System Manager PE or System Manager SE
from SMS 4.0.1, also called SMS 4.0, Service Update 1 (SU1). In this upgrade, you will
install SMS 4.0 Service Update 2 (SU2), if it is not already installed, as well as the
Advanced Reports add-on.
Before you begin, ensure that you have met all of the requirements listed in “Prerequisites”
on page 3 and “Required Components for Installation” on page 55. You must also have
installed SMS 4.0.1. After these requirements have been met, follow the steps below to
upgrade to the SMS 4.0.1, Advanced Reports add-on.

Administrative Concerns for Advanced Reports
Required Components for Installation
Note that the requirements for SMS SU1 (see “Prerequisites” on page 3) also include
requirements for the Advanced Reports add-on. These include a requirement that Internet
Explorer version 6 is installed, and that many of the operating systems have recent service
packs.

When Data Execution Prevention (DEP) is on the Computer
According to the Microsoft Help and Support site, “DEP is a set of hardware and software
technologies that perform additional checks on memory to help prevent malicious code
from running on a system.” When DEP is on a computer, you may not be able to run the
Advanced Reports install. If you see a message telling you that the install cannot continue
because of hardware-based Data Execution Protection, the install will stop. Contact your
local Schneider Electric representative for help in disabling DEP. After Advanced Reports
is installed, you can enable DEP again.

Changing Computer Settings
If you want to add the Advanced Reports server computer to your domain, do so before
you install Advanced Reports. If you add the computer to the domain after installing
Advanced Reports, many of the Advanced Reports services will be unable to run. If you
change the domain after you have installed Advanced Reports, you must use the Crystal
Configuration Manager (Start > Programs > Crystal Enterprise 10 > Crystal Configuration
Manager) to delete, and then recreate, all Crystal Enterprise services.
Likewise, do not change the computer name after you install Advanced Reports. If you do
so, you will most likely need to reinstall Advanced Reports.

Changing SA Password
If you want to change the password for the SQL “sa” account, make the change before
you install Advanced Reports. If you change the password after Advanced Reports is
installed, Crystal Enterprise will be unable to connect to the database.
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Installation Steps, SMS PE
Follow these steps to install the Advanced Reports SMS PE product:
1. Use the Database Services function in SMS to back up the SMS database.
2. Shut down SMS and all other Windows applications.
3. Insert the Advanced Reports Launchpad disk in the CD-ROM drive of the SMS 4.0
server computer.
If you have disabled your computer’s autorun feature, you will need to launch the
installation manually. To do this, click Start > Run, then browse to locate the CD
named LP_ADV_RPTS40. Double-click setup.exe. At the Run screen, click OK.
If you are installing on a computer that has Terminal Services or Terminal Server
installed (typically, Windows 2000 Server or Windows Server 2003), the Terminal
Server Install Failure screen displays.
4. Open the Control Panel and click Add/Remove Programs
5. At the Add/Remove Programs screen, click Add New Programs.
6. At the next screen, check CD or Floppy, then click Next.
7. At the Run Installation Program screen, browse to the CD-ROM drive.
8. At the Browse screen, select setup.exe; then click Open.
9. When the Run Installation Program displays again, click Next.
If your computer has not met the suggested hardware requirements, a prompt displays
telling you that “your computer does not meet the suggested requirements for optimal
performance.” Click Yes to continue the install, or click No to terminate the install.
If you have not yet installed required components, they will be listed on the Launchpad
Prerequisites screen:
— The components that are listed must be installed before you can continue the
installation. Make a note of these components, then click Next to exit the install.
Install the prerequisites. See “Prerequisites” on page 3 for instructions.
— After all prerequisites are installed, you can restart the installation.
10. When the Welcome screen displays, click Next.
The System Manager Software License Agreement screen displays.
11. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer.
To continue the installation, click Yes. To terminate the installation, click No.
12. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
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After the computer restarts, the Launchpad screen displays:

All components that have a red check are already installed. In the example above, only
MSSQL2000 is installed. If you have already installed SMS 4.0.1, SU2, you can skip
the next section and go to “Installing Crystal Enterprise” on page 58.

Installing SMS 4.0.1, Service Update 2 (SU2)
13. Click the SMS Service Update 2 button.
NOTE: If you have .NET Framework, Version 2.0 installed on this computer, you will
see an application error. Click OK, which allows the install to continue. SMS SU2
addresses the issue related to the error.
14. After several messages, the Welcome screen displays. Click Next.
A caution message displays, telling you that you need to back up your SMS database.
15. If you have not yet backed up your SMS database, click No.The install will terminate.
Use Database Services to back up your database. See Backing Up the Database
below.
16. When the SMS database is backed up, click Yes to continue the install.
17. At the Ready to Install the Program screen, click Install.
18. Several progress messages display, which can take a few minutes.
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Installing Crystal Enterprise
The Launchpad screen displays, showing that SMS Service Update 2 and Microsoft
SQL2000 are installed:

If you have already installed Crystal Enterprise on this computer, the Crystal
Enterprise button is already checked. You can skip to “Installing the Advanced Reports
Framework” on page 58.
19. Click the Crystal Enterprise button.
20. When prompted to insert the Crystal Enterprise CD, remove the Advanced Reports
Launchpad disk and insert the Crystal Enterprise disk. Allow the CD to completely
load, then click OK.
It will take several minutes to install Crystal Enterprise (for a system that only meets
minimal requirements, it could take 10 to 20 minutes).

Installing the Advanced Reports Framework
The Launchpad screen displays, showing that Crystal Enterprise is installed:

21. Click the Advanced Reports Framework button.
22. When prompted to insert the Advanced Reports CD, remove the Crystal Enterprise
disk and re-insert the Advanced Reports Launchpad disk. Allow the CD to completely
load, then click OK.
23. When the Welcome screen displays, click Next.
The System Manager Software License Agreement screen displays.
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24. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer.
To continue the installation, click Yes. To terminate the installation, click No.
25. At the Select a Drive screen, we recommend that you accept the default C: drive. Click
Next.
26. At the Ready to Install the Program screen, click Install.
Several progress messages display Advanced Reports Framework is being installed.

Installing the Pre-Defined Reports
The Launchpad screen displays, showing that the Advanced Reports Framework is
installed:

27. Click the Pre-Defined Reports button.
Several progress messages display while the predefined advanced reports are being
installed.
The Launchpad screen displays, showing that the predefined advanced reports are
installed:

28. Click FINISH.
After several update messages, a welcome screen displays.
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29. Click Next to display the SMS History Data Import screen:

30. Choose one of the following options, then click Next. For instructions about using each
option, see “Importing History Data from the Previous Version of SMS” on page 71.
— Fast Data Import (default): SMS must be offline for this entire process. This
process imports only SMS_History. With large databases (10 GB or larger), this
could mean being offline for several days.
— Online Data Import: Although this is a much slower process than the fast data
import, it does allow you be online with SMS while data is being imported. YOu can
choose whether to import SMS_History or one or more archive files.
— No Data Import: Skip the data import sections below. You can import data at a
later time.

Running SMS as a Windows Service
The About the SMS Account Selection Dialog screen displays. This screen describes
the procedure for determining whether SMS will run as a Windows service.
31. Read this information; then click Next.
Windows Server 2003 only: A message displays asking if you have added the
account to the IIS_WPG group. If the account you used to log on to the computer is not
in the IIS_WPG, you must add it now. For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS installation
to add the account to the IIS_WPG.
After the account is added to the IIS_WPG, click Yes.
The Run Mode screen displays:
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32. On this screen, you choose whether you will run SMS as a Windows service. When
you run SMS as a Windows service, the SMS server automatically restarts every time
the server computer is restarted. To ensure that data is always available to remote
browsers, we strongly recommend that you run SMS as a service.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows Administrator account; or select the account from the list in the box.
The account cannot have a blank password; enter the account’s password, then retype
the password to verify it. This account is used to synchronize the Windows account
with SMS components.
For Cross-Language Installations: If you are running SMS on an operating system
that does not use the same language (such as French SMS on an English operating
system), you need to enter the administrator account that you have specified for this
purpose (see “Cross-Language Installations” on page 7).
If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is also a member of the IIS
Worker Process Group (IIS_WPG group). For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS installation
to add the account to the IIS_WPG.
33. After you type the account and password, click Next.
34. At the Ready to Install the Program screen, click Install.
When the System Manager Software Registration Form dialog displays:

35. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers one SMS 4.0 client access license (browser access), is
printed on the CD case and on a card that is in your software package.

Note
To increase the number of simultaneous browser connections, you can purchase an optional
product called WebXTR. See your Schneider Electric representative for assistance.

36. To register your SMS 4.0 software, click one of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
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review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the completed form. Close the registration
form window and the Registration window. Fax or mail the completed form to your
local Schneider Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS. >
Registration.
37. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
If you chose either Fast Data Import or Online Data Import at the SMS History Data
Import screen, a history log-in screen displays.
38. Enter an SMS user ID and password (level 1, 2, or 3); then click Login. The appropriate
history import screen displays. For instructions on importing data, see “Importing
History Data from the Previous Version of SMS” on page 71.
SMS is now installed. Remember to install any missing components.
If you need to install optional products, such as GFX, see the instruction sheet that you
received with the installation CD.
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Installation Steps, SMS SE
Follow these steps to install the Advanced Reports SMS SE product:
1. Use the Database Services function in SMS to back up the SMS database.
2. Shut down SMS and all other Windows applications.
3. Insert the Advanced Reports Launchpad disk in the CD-ROM drive of the SMS 4.0
server computer.
If you have disabled your computer’s autorun feature, you will need to launch the
installation manually. To do this, click Start > Run, then browse to locate the CD
named LP_ADV_RPTS40. Double-click setup.exe. At the Run screen, click OK.
If you are installing on a computer that has Terminal Services or Terminal Server
installed (typically Windows 2000 Server or Windows Server 2003), the Terminal
Server Install Failure screen displays.
4. Open the Control Panel and click Add/Remove Programs
5. At the Add/Remove Programs screen, click Add New Programs.
6. At the next screen, check CD or Floppy, then click Next.
7. At the Run Installation Program screen, browse to the CD-ROM drive.
8. At the Browse screen, select setup.exe; then click Open.
9. When the Run Installation Program displays again, click Next.
If your computer has not met the suggested hardware requirements, a prompt displays
telling you that “your computer does not meet the suggested requirements for optimal
performance.” Click Yes to continue the install, or click No to terminate the install.
If you have not yet installed required components, they will be listed on the Launchpad
Prerequisites screen:
— The components that are listed must be installed before you can continue the
installation. Make a note of these components, then click Next to exit the install.
Install the prerequisites. See “Prerequisites” on page 3 for instructions.
— After all prerequisites are installed, you can restart the installation.
10. When the Welcome screen displays, click Next.
The System Manager Software License Agreement screen displays.
11. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer.
To continue the installation, click Yes. To terminate the installation, click No.
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12. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
After the computer restarts, the Launchpad screen displays:

Any components that have a red check are already installed. In the example above,
none of the components is installed. If you have already installed SMS 4.0.1, SU2 and
Microsoft SQL 2000, you can skip these sections and go to “Installing Crystal
Enterprise” on page 58.
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Installing SMS 4.0.1, Service Update 2 (SU2)
13. Click the SMS Service Update 2 button.
14. When the Welcome screen displays, click Next.
NOTE: If you have .NET Framework, Version 2.0 installed on this computer, you will
see an application error. Click OK, which allows the install to continue. SMS SU2
addresses the issue related to the error.
15. After several messages, the Welcome screen displays. Click Next.
A caution message displays, telling you that you need to back up your SMS database.
16. If you have not yet backed up your SMS database, click No.The install will terminate.
Use Database Services to back up your database. See Backing Up the Database
below.
17. When the SMS database is backed up, click Yes to continue the install.
18. At the Ready to Install the Program screen, click Install.
19. Several progress messages display, which can take a few minutes.

Installing Microsoft SQL 2000
The launchpad screen displays, showing that SMS SU2 is installed:

If you have already upgraded MSDE2000 to SQL2000 Standard or Personal, the
Microsoft SQL2000 button is checked. You can skip to “Installing Crystal Enterprise”
on page 66.
20. If you have not yet upgraded to SQL2000 Standard or Personal, click Microsoft
SQL2000.
21. Follow the correct step for the operating system you are using:
Windows 2000 Server or Windows Server 2003: When prompted to insert the
SQL2K Standard CD, remove the Components disk and insert the SQL2K Standard
disk in the CD-ROM drive.
Windows XP: When prompted to insert the SQL2K Personal CD, remove the
Components disk and insert the SQL2K Personal disk in the CD-ROM drive.
22. Allow the CD to completely load, then click OK. Click Next at the InstallShield Wizard
Welcome screen.
23. At the Computer Name screen, accept the default of “Local Computer” and click Next.
24. At the Installation Selection screen, click “Upgrade, remove, or add components to an
existing instance of SQL Server.” Click Next.
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25. At the Instance Name screen, select the SMS instance that was used in the previous
SMS release (for example, SMS3000 or SMS1500).
26. At the Existing Installation screen, accept the default: “Upgrade your existing
installation.” Click Next.
27. At the Upgrade screen, check “Yes, upgrade my programs.” Click Next.
28. At the “Do you want to install additional components?” prompt, click Yes.
The Select Components screen displays.
29. In the left-hand pane, check:
— Management Tools
— Books Online
Do not change any other options.
Click Next.
30. At the Start Copying Files screen, click Next.
Several progress messages display while SQL 2000 is being installed. This could take
a few minutes.
31. At the Setup Complete screen, click Finish.

Installing Crystal Enterprise
The Launchpad screen displays, showing that SMS Service Update 2 and Microsoft
SQL2000 are installed:

If you have already installed Crystal Enterprise on this computer, the Crystal
Enterprise button is already checked. You can skip to “Installing the Advanced Reports
Framework” on page 58.
32. If you need to install Crystal Enterprise, click Crystal Enterprise.
33. When prompted to insert the Crystal Enterprise CD, remove the previous disk and
insert the Crystal Enterprise disk. Allow the CD to completely load, then click OK.
It will take several minutes to install Crystal Enterprise (for a system that only meets
minimal requirements, it could take 10 to 20 minutes).
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Installing the Advanced Reports Framework
The Launchpad screen displays, showing that Crystal Enterprise is installed:

34. Click the Advanced Reports Framework button.
35. When prompted to insert the Advanced Reports CD, remove the Crystal Enterprise
disk and re-insert the Advanced Reports Launchpad disk. Allow the CD to completely
load, then click OK.
36. When the Welcome screen displays, click Next.
The System Manager Software License Agreement screen displays.
37. Before you continue, read the license agreement to be sure you accept its terms. If you
want to print a copy of the text, click Print; the text prints at the default printer.
To continue the installation, click Yes. To terminate the installation, click No.
38. At the Select a Drive screen, we recommend that you accept the default C: drive. Click
Next.
39. At the Ready to Install the Program screen, click Install.
Several progress messages display while Advanced Reports Framework is being
installed.

Installing the Pre-Defined Reports
The Launchpad screen displays, showing that the Advanced Reports Framework is
installed:
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40. Click Pre-Defined Reports.
Several progress messages display while the predefined advanced reports are being
installed.
The Launchpad screen displays, showing that the pre-defined reports are installed:

41. Click FINISH.
42. When the Welcome screen displays, click Next.
The SMS History Data Import screen displays:

43. Choose one of the following options, then click Next. For instructions about using each
option, see “Importing History Data from the Previous Version of SMS” on page 71.
— Fast Data Import (default): SMS must be offline for this entire process. This
process imports only SMS_History. With large databases (10 GB or larger), this
could mean being offline for several days.
— Online Data Import: Although this is a much slower process than the fast data
import, it does allow you be online with SMS while data is being imported. YOu can
choose whether to import SMS_History or one or more archive files.
— No Data Import: Skip the data import sections below. You can import data at a
later time.
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Running SMS as a Windows Service
The About the SMS Account Selection Dialog screen displays. This screen describes
the procedure for determining whether SMS will run as a Windows service.
44. Read this information; then click Next.
Windows Server 2003 only: A message displays asking if you have added the
account to the IIS_WPG group. If the account you used to log on to the computer is not
in the IIS_WPG, you must add it now. For instructions on adding a user to the
IIS_WPG, see “Prerequisites” on page 3. You do not need to exit the SMS installation
to add the account to the IIS_WPG.
After the account is added to the IIS_WPG, click Yes.
The Run Mode screen displays.

45. On this screen, you choose whether you will run SMS as a Windows service. When
you run SMS as a Windows service, the SMS server automatically restarts every time
the server computer is restarted. To ensure that data is always available to remote
browsers, we strongly recommend that you run SMS as a service.
To run SMS as a Windows service: Do not check the box at the top of the screen.
Enter a Windows administrator account (or select an account from the list in the box).
The account cannot have a blank password: enter the account’s password, then retype
the password to verify it. This account is used to synchronize the Windows account
with SMS components.
For Cross-Language Installations: If you are running SMS on an operating system
that does not use the same language (such as French SMS on an English operating
system), you need to enter the administrator account that you have specified for this
purpose (see “Cross-Language Installations” on page 7).
. If you are installing SMS on a computer that has Server 2003 as its operating system,
you must enter a Windows Administrator account that is also a member of the IIS
Worker Process Group (IIS_WPG group).
46. After you type the account and password, click Next.
47. At the Ready to Install the Program screen, click Install.
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The System Manager Software Registration Form dialog displays:

48. Have your SMS 4.0 product serial number available before you begin.The serial
number, which registers one SMS 4.0 client access license (browser access), is
printed on the CD case and on a card that is in your software package.
NOTE: To increase the number of simultaneous browser connections, you can
purchase an optional product called WebXTR. See your Schneider Electric
representative for assistance.
49. To register your SMS 4.0 software, click one of the option buttons:
— Online Registration. Click this button to launch your Internet browser and display
the online registration form. Follow instructions to complete the form. Click Next to
review the information that you enter. When the information is correct, click Submit
to send it. Close your browser, close the Registration window.
— Complete and Print. Click this button to display a copy of the registration form.
Complete the fields online; then print the completed form. Close the registration
form window and the Registration window. Fax or mail the completed form to your
local Schneider Electric representative.
— To register at a later time, click Close. The software registration form will display
when you restart your computer. If you close that dialog without registering, locate
the form on your computer at Start > Programs > POWERLOGIC > DOCS. >
Registration.
50. When the Machine Reboot Required message displays, click OK. At the Windows
login screen, you must log in with a Windows Administrator password.
If you chose either Fast Data Import or Online Data Import at the SMS History Data
Import screen, a history log-in screen displays.
51. Enter an SMS user ID and password (level 1, 2, or 3); then click Login. The appropriate
history import screen displays. For instructions on importing data, see “Importing
History Data from the Previous Version of SMS” on page 71.
SMS is now installed. Remember to install any missing components.
If you need to install optional products, such as GFX, see the instruction sheet that you
received with the installation CD.
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Recreating Information Manager Reports
If you created any Information Manager reports in your earlier version of SMS, you will
need to recreate them in Advanced Reports. A new tool called the Information Manager
Report Configuration Utility (IMRC) detects the old reports and creates a file that you can
view. This file gives you the device/topic/setup data you need to create the new reports.
There are two ways to access the IMRC:

• From with the SMS Setup Utility, click Tools > Report Configuration
• Choose C:\POWERLOGIC\InfoManager\Bin\PLReportReader.exe
You can export this report as a PDF or an HTML file. Access the exported file in the SMS
browser (System > Documentation). It is stored in the SMS/Web/Maintenance folder.
The IMRC has an online help file, which will give you instructions on reading this report.

Importing History Data from the Previous Version of SMS
Using the Fast Data Import
After you choose Fast Data Import, the Advanced Reports Fast Importer screen displays:

SQL Settings

Information

Process Status

Buttons

Follow these instructions for each of the noted items in the graphic above:
SQL Settings: The Database Server line displays the SQL instance for SMS. You should
not have to change this box. The User and Password display the SMS default ID and
password for the SQL user account. Change these fields only if you have changed the
default SQL account and password for SMS.
Information: Indicates whether the connection test passed, whether you can begin
importing, and when the import has completed.
Process Status: during the data import, indicates the state of each of the four items. The
“Estimated time remaining” is affected by many factors, such as whether you made recent
changes to the database (changes to log templates and addition of devices, for example).
Buttons: Click Begin Data Transfer to start the import. There is no option to pause the
process. If you click Close, the import ends. When you click Begin Data Transfer again, it
will start over from the beginning.
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Using the Online Data Import
After you click Online Data Import, the SMS History Import Utility screen displays:

SQL Settings

Import
SMS-History

Archive Files

Buttons

Status
Progress

Follow these instructions for each of the noted items in the graphic above:
SQL Settings: The Database Server line displays the SQL instance for SMS. You should
not need to change this box. The DB Server User and Password display the SMS default
ID and password for the SQL user account. Change these fields only if you have changed
the default SQL account and password for SMS.
Import SMS_History: Check this box to import only the SMS_History file. You cannot
import archive files at the same time that you import SMS_History.
Archive Files: Click the browse button (
) to display the archive files. Select one or
more files to import. You cannot import archive files at the same time that you import
SMS_History.
Status: Displays information such as when the system is ready to import or if the
connection test failed.
Progress: Displays a bar telling you how much of the import is completed.
Buttons:

• Click “Check Connection” to verify that the importer is communicating with the SQL
server and is ready to import data.

• Click “Being Import” to start.
• Click “Pause” to suspend importing, but not stop it; when the import is paused, the
button name changes to “Resume,” so that you can begin importing from the point at
which you paused.

• Click “Stop” to terminate the import. When you restart, the import will start importing at
the beginning of the file.

• Click “View Log” to see the progress of the logs that are currently being imported.
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Importing Data After SMS is Installed
1. Click Start > Programs > POWERLOGIC > Tools > Fast Import Utility to launch the fast
importer. Or click Start > Programs > POWERLOGIC > Tools > Online Import Utility to
launch the online importer.
2. Follow the instructions on the previous pages for the fast import. or the online import.

Optional Installs
If you have purchased optional add-on software (for example, GFX or WebXTR), you can
install them now. Use the CD and installation instructions provided with the add-on
product.
You may have previously installed optional devices--such as a Sepam device, PM500, or
PM9C-before you began the SMS upgrade. If any of these devices were installed, you
should re-run the optional install for each device type now. This will ensure that all of the
device type updates are properly installed.

Reinstalling the Advanced Reports add-on
If you want to reinstall the entire SMS 4.0.1 application, including all add-ons, see
“Reinstalling SMS 4.0.1” on page 35.
If you want to reinstall Advanced Reports without reinstalling all of SMS and the other addon software, follow these instructions:
1. Use the Advanced Reports Database Management tool to make a backup copy of your
history database. Access this tool from the SMS Setup client: click Setup >
Administrative > Advanced Reports > Database Management.
2. Insert the Advanced Reports Launchpad CD in the CD-ROM drive of the SMS server
computer.
3. Follow on-screen instructions to reinstall Advanced Reports.
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Using SMS 4.0
This chapter provides information on accessing SMS 4.0, using a browser and launching
SMS Setup, and using reports.

Accessing SMS 4.0
This section describes how to access the SMS 4.0 server from the server computer, and
how to deploy SMS 4.0 (provide SMS 4.0 access) to remote users.

Using a Power User Account when Running SMS
We recommend that you are logged on the server with an Administrator-level account
when running SMS, but you may use a Power User-level account instead.

Accessing the Server Computer
To access the SMS 4.0 server computer, follow these steps:
1. At any computer that will access SMS 4.0, ensure that you do not have your computer
set for “large fonts.” This setting is found in the Control Panel.
2. Be sure that IIS is running. If it is not running, you will not be able to access the SMS
4.0 browser main window.
3. Launch the SMS 4.0 browser: From the server computer, click Start > Programs >
POWERLOGIC > System Manager Software.
If your user account does not provide high enough security, you see a message telling you
that Internet Explorer’s Enhanced Security Configuration is enabled. This prevents you from
viewing the SMS browser page. To enable viewing of the browser, add it to the Intranet or
Trusted Sites for your user ID. Do this in Internet Explorer (click Tools < Internet Options.
Then go the Security tab.)
The first time you access the SMS 4.0 server, you see this Security Warning screen:

4. To ensure that the tree control in the left pane displays, you must install these
POWERLOGIC ActiveX controls. Click Yes.
If errors display after you click Yes at the Security Warning, your Windows account
security may not permit installation of the user interface controls. To install them, you
must be a power user or administrator on the remote computer. Contact your system
administrator for help.
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The POWERLOGIC Web Client login screen displays:

5. Enter a valid login ID and password for the SMS software installed on the host computer.
This is the user account that is created in SMS Setup. The user account that you use
must have both ID and password (blanks not acceptable). You receive this ID and
password from your POWERLOGIC system administrator.
The SMS 4.0 home page displays:

Delivering SMS 4.0 to System Users
Establishing User Names and Passwords
Before users will be able to access and use SMS 4.0, you must establish user names and
passwords in the SMS Setup Utility. SMS users will enter their name and ID when
accessing SMS from SMS Setup or the browser. All user names and passwords give
access to every feature in the browser. However, users can be given different levels of
access to SMS Setup. See the SMS Setup online help file for a table that illustrates user
access levels.
To add SMS user names and passwords, open SMS Setup from the SMS 4.0 server, then
access the user accounts feature (Setup > Administrative > User Accounts). For
instructions, see SMS Setup online help file.
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Notifying Users
Once you have set up user names and passwords, you must give each user the following
information:

• the user ID and password they are to use when accessing SMS 4.0
• the URL link to the SMS 4.0 server computer
Opening an SMS 4.0 Browser Session as a Remote User
To open an SMS 4.0 session from a remote computer, follow these steps.
1. The SMS 4.0 server must be accessible. If it is not, follow instructions in “Accessing
the Server Computer” on page 75 to launch the browser.
2. At the remote computer, open Internet Explorer.
3. Enter the computer name or IP address for the SMS 4.0 server computer, followed by
“/powerlogicweb.” Your system administrator can give you the name or address of the
server computer.
For example, if the computer name is “webserver,” the name to be entered at the
remote computer would be:
http://webserver/powerlogicweb
The first time you open an SMS 4.0 session at a remote computer, the following
Security Warning screen displays:

4. To ensure that the tree control in the left pane displays, you must install these
POWERLOGIC ActiveX controls. Click Yes.
The tree control displays when you click a tab—such as Meters or Bar Charts—on the
SMS browser main window. If the left pane does not display the tree control, your
Windows account security did not permit installation of ActiveX controls. To install
ActiveX controls, you must be a power user or administrator. Contact your system
administrator to remedy the situation.
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The POWERLOGIC Web Client login screen displays:

5. Enter a valid login ID and password for the SMS software installed on the host computer.
This is the user account that is created in SMS Setup. The user account that you use
must have both ID and password (blanks not acceptable). You receive this ID and
password from your POWERLOGIC system administrator.
The SMS 4.0 home page displays:
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When Maximum Number of Connections is Met
When the maximum number of allowable browser sessions has been reached, you see
the following screen when you try to log into the SMS browser:

All of the users who have a browser session open are listed. If you have entered an
administrator-level SMS account (level 1), you can disconnect another user.
To disconnect the user, check the Selection box, then click Disconnect. Your browser
session will begin immediately.

Accessing the SMS Advanced Reports Add-on Application
To launch Advanced Reports, follow these steps:
1. From the server computer, click Start > Programs > PowerLogic > Advanced Report.
Or, from the SMS browser, select the History tab; then click Advanced Reports
2. When you are prompted for a password, enter your SMS ID and password.
When the Advanced Reports window opens, refer to the Advanced Reports online help
file for instructions on using Advanced Reports.

If Advanced Reports does not
Open Correctly

If Advanced Reports does not open correctly, consider these possibilities:
• Windows Server 2003 only: If the Advanced Reports browser window does not display,
add the website to your trusted sites. The website address to add is:
http://pcaddress/Powerlogic/AdvancedReports/Default.aspx
where “pcaddress” is the name of the server computer.
For help in adding the browser to your trusted sites, contact your system administrator.
• If you change the Windows SA password after you install Advanced Reports, you will be
unable to log in to Advanced Reports. You must reset the password and then restart the
Crystal Enterprise services. If you need help with this, contact your local Schneider
Electric representative.
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• If you launch Advanced Reports from the Start menu, it should always be with a new
instance of Internet Explorer. If, however, the Advanced Reports browser window opens
in the existing browser window (closing the SMS browser window), do the following:
With Internet Explorer open, click Tools > Internet Options. On the Advanced tab,
uncheck “Reuse windows for launching shortcuts.” Click OK.

Restarting the Crystal Management Server
If the browser does not open and the following message displays, you will need to restart
the Crystal Management Server.
“Unable to retrieve cluster members. CMS host 'yourpc' can be contacted, but there is no
CMS running at port 6400.”
To restart the browser, click Start > Programs > Crystal Enterprise 10 > Crystal
Management Server.
Note the icons to the left of each server name. For any server with a red icon (server is
stopped), right-click the server name and choose Start. Close the Crystal Configuration
Manager. You should now be able to launch Advanced Reports.

Accessing the SMS Setup Client
To access SMS Setup, follow these steps:
1. From the server computer, click Start > Programs > POWERLOGIC > SMS Setup.
The SMS Setup Login screen displays:

2. Enter the SMS User ID and password that have been assigned to you. Click OK.
SMS 4.0 splash screen displays, followed by the SMS Setup Utility main window:

3. For help using SMS Setup, click Help > Setup Utility Help.
If there are already devices in your SMS Setup Utility, and any of them have lost
communication with SMS, the System Device Status screen displays. For help in
bringing devices back into service, click Help on this screen.
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Customizing the SMS Interface
The SMS browser is designed with a default appearance. You may wish to make some
changes to customize this appearance. For example, you might want to use your company
logo as part of the SMS browser main window.
However, you cannot make any changes to the SMS functionality. If you have questions
about customizing SMS, contact your local Schneider Electric representative.

Customizing the About Box Icon and Banner
The SMS icon at the upper right of the browser screen and the blank banner space
indicated in Figure 1– 1 are default graphics. You can replace either or both of these
graphics with your own graphics.
To replace one of these graphics, follow these steps:
1. From the server computer, locate the two graphic files:
• defaultLogo.JPG (the About box)
• DefaultBanner.jpg (the banner)
These files are in the POWERLOGIC\SMS\Web\Logos folder.
2. You can replace one or both of these graphics with your own graphics. Be sure to use
replacement graphics that are the same size and type (for example, .jpg) as the defaults.
3. After you replace the graphic(s), delete the temporary Internet Explorer files that
reference the old graphics. Follow these steps:
• On the SMS server computer and on each remote computer that will open SMS 4.0
browser sessions, launch Internet Explorer. Click Tools > Internet Options. The
General tab displays.
• In the Temporary Internet Files box, click Delete Files. When the Delete Files screen
displays, check the “Delete all offline content box” and click OK.
• Click OK to close the Internet Options screen.
The new graphic(s) will display in the browser screen. In Figure 1– 1 below, both graphics
are replaced. The banner will only display on the SMS browser home page. When you
click on a tab to display information, the banner disappears.

Figure 1– 1: Home page with customized About box and banner
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For information about using features in the SMS 4.0 browser, see the SMS 4.0 online
user’s guide: Click System > Documentation and Links; from the tree control, select SMS
4.0 User’s Guide.
For information about using the SMS Setup Utility, see the SMS Setup Utility help file:
From within SMS Setup, click Help > Setup Utility Help.

Storing Document Files and Web Links
You can store document files and links to web sites on the server computer in the
POWERLOGIC\SMS\Web\Maintenance folder. Once they are stored, you can view them
using the Documents and Links option on the System tab.

Files from Earlier Versions of SMS
When upgrading from an earlier version of SMS, only documents with these extensions
will display in the Documentation list:

• .htm
• .html
• .asp
• .pdf
Files with other extensions are also moved to the Maintenance folder, but they do not
display in the Documentation list. If you want to view these other files in the SMS browser,
you must do one of the following:

• convert each file to one of the extensions listed above
• create a file, such as an .html file, to link to each document
Viewing and Adding Links
When you view a PDF document, the Adobe Acrobat Reader plug-in is launched within the
browser window. If you want to view a PDF document from a computer that does not have
Acrobat Reader installed, you can download it from the Adobe website, www.adobe.com.
Several links are already loaded on the server computer: Internet links to Square D and
Schneider Electric web pages, and an HTML version of this manual. Additional documents
and HTML links that you might want to add are: power equipment drawings, additional user
guides, or links to your own web site.
To add a document or web link, place it in the POWERLOGIC\SMS\Web\Maintenance
folder on the SMS 4.0 server computer. As soon as the document or web link is added to
the Maintenance folder, it is available for use; click the home icon to refresh the view and
display the link.

Information Manager Considerations
Information Manager is the reports feature in System Manager DL and System Manager
Standard (when the optional Advanced Reports add-on is not installed).
Information Manager allows you to create, schedule, print, and view reports containing
historical data from PowerLogic System devices. If you need help creating and using
reports, see the online help file that is in Information Manager. To access the help file,
open Information Manager, then click Help > Contents.
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You can add, edit, and schedule Information Manager only from the server computer.
However, you can use the browser to view reports from any remote computer.
Once you create a report, its name displays in the left pane of the Historical tab of the
SMS 4.0 main window.
You can view the report from any remote computer that accesses SMS 4.0, without
launching SMS Setup on the server computer. To view a report, click its name; it displays
in the right pane of the SMS 4.0 window. The following is an example of a historical data
trend report.

Printing Information Manager Reports
You can automatically print reports from Information Manager on the SMS server
computer. (The Information Manager help file describes how to schedule each type of
report.) Although remote users cannot schedule reports, they can print reports manually:
1. Display the report (to open it, click the report name that displays in the left pane of the
SMS browser window).
2. With the report displayed, click the right pane of the SMS window. This selects that
pane for printing.
3. From the browser toolbar, select File > Print.
4. When the Print screen displays, select the printer and click Print.
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